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ABSTRACT 
 

As a visual testament to the complexity of ancient peoples, rock markings have 
long captivated the public imagination. More recently, the archaeological field has 
witnessed a renaissance in rock marking scholarship as researchers increasingly 
recognize both the continued importance of these features to descendant 
communities and their potential to inform our understandings of antiquity. In the 
semiotic content of petroglyphs and pictographs, many archaeologists see an 
opportunity to access otherwise irretrievable details of past belief systems. Yet, 
attempts to engage with this content are complicated by the immense challenge 
researchers face in delineating the boundaries and details of rock markings. 
Sketches, charcoal rubbings, and – since the advent of photography – pictures of 
chalk-marked stones comprise just a few of the subjective recording methods 
applied to documenting these features. As a result, entirely different drawings 
often exist for the same petroglyphs, and from their widely divergent starting 
points scholars have unsurprisingly arrived at antipodal interpretations. 
 
In the last couple decades, archaeologists have brought new technology to bear 
on this subject. Increasingly prevalent in the documentation of rock markings are 
three-dimensional recording techniques such as digital photogrammetry, LiDAR, 
and structured-light scanning. Despite a growing body of 3D spatial data, we still 
lack a comprehensive and objective methodology for making appropriate use of 
this new class of information. This study presents new techniques for leveraging 
the data potential of 3D petroglyph scans in the creation of objective 
visualizations of rock markings. It outlines and then demonstrates a process of 
uniform manipulations performed on 3D petroglyph data in CloudCompare, a free 
3D modelling software, for the purpose of achieving improved visual contrast of 
rock carvings. It also evaluates some existing methods and tools for colorizing 
images on stone. The methodology offered here can contribute significantly to 
petroglyph research as it fulfills the need for a systematic route to increasing 
glyph clarity, yet does so in a more objective manner than traditional 
segmentation techniques. In this role, it has the capacity to make visible 
previously unidentified markings. The use of this process on a dataset primarily 
from the Eastern United States facilitated the discovery of unrecognized 
petroglyphs at known petroglyph sites. Moreover, this process may prove 
applicable to other archaeological problems, such as reading eroded 
gravestones. 
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Chapter 1: Introduction to the Research 

What was once a marginalized and neglected subject in mainstream archaeology 

is undergoing a promising resurgence. Today, tourists flock to publicly accessible rock 

marking sites (and at times trespass to observe private ones). Researchers the world 

over gather for interdisciplinary study of the same. Native nations commemorate and 

engage with spaces that record histories longer than written record. But if we ask an 

individual what they see, the answer varies depending on the person. If we ask what is 

truly there – where the markings begin and end – the answer becomes more 

complicated still. Key to any science is the ability to make accurate, empirical 

observations and then to accurately convey those observations to a wider audience. 

Simple, diagrammatic recordings of images on stone have remained elusive, however, 

due to both the limited technological means previously at the archaeologist’s disposal 

and inherent complications posed by this category of feature. Erosion distorts and hides, 

natural features camouflage and deceive, and lighting conditions reveal or conceal. This 

is to say nothing of the inherent biases of the researcher which we must still contend 

with. All of these factors challenge the detection and adequate recording of rock 

markings using the most accurate and objective means until now available. 

This work intervenes in the standard ways of depicting petroglyphs and offers a 

different path forward. This first chapter presents the background of the study, specifies 

the problem it addresses, describes the research design, and outlines the aims of the 

work. The greater portion of this chapter is then dedicated to reviewing the relevant 

literature. The second chapter looks at the experiments and evaluations conducted in 

the development of a methodology, reviews the immediate results, and applies the 

developed methodology to a brief case study. The third and final chapter summarizes my 

efforts and reflects on the findings. It additionally discusses insights from this research 
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as well as their implications for the field, lastly providing recommendations for future 

research. 

Background of the Study 

It would be helpful to first describe some developments in archaeological 

research on petroglyphs which had implications for the conceptualization of this study. 

This work was conducted at a time when the archaeology of rock markings is in flux. 

Today, a burgeoning interest and awareness of rock-borne imagery has garnered 

renewed attention from academia (David and Wilson 2002; Diaz-Granados and Duncan 

2004; McDonald and Veth 2012; Gillette et al. 2014; Agnew et al. 2015; Stebergløkken 

et al. 2015; Diaz-Granados et al. 2018; Nash and Mazel 2019; Moro Abadía and Porr 

2021; Davidson and Nowell 2021). The study of rock-borne imagery is increasingly being 

recognized for its potential to meaningfully expand our knowledge of prehistoric 

Indigenous cosmologies and cultural landscapes, as well as the opportunity to perform 

research that resonates with Native peoples and attests to both continuities and ruptures 

in the wake of colonial processes. 

The willingness of professional archaeologists to seek out, record, and interpret 

images on stone still constitutes a relatively recent development in the United States, 

spurred on by the discoveries of avocational researchers and Section 106 work, growing 

recognition of the need to protect and preserve these cultural resources, and the political 

and cultural resurgence of Native American nations (Beaudoin and Eagle 2009; Whitley 

2013; Hale 2010; Associated Press 2021; Hanson et al. 2022). Many of the latter groups 

have assumed archaeological responsibilities on their lands through Tribal Historic 

Preservation Offices and today count among their ranks Native archaeologists who are 

eager to reengage with ancestral places from which their communities have frequently 

been alienated and dispossessed (Colwell-Chanthaphonh et al. 2010; Nicholas 2014; 

Dring et al. 2019). In the past authors have frequently shoehorned rock markings into a 
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concocted binary opposition between the functional and the religious, but non-native 

researchers have in recent years beneficially expanded their interpretations, such as by 

exploring how contemporary descendant communities engage with ancestors through 

rock-borne imagery (Brady 2016). 

Yet, the many new directions being taken in this area of study are juxtaposed by 

the dearth of available data, and in rushing to interpretation many authors have sought 

to run before we can walk. Difficulties dating, objectively recording, and even finding 

petroglyphs and pictographs have hampered our efforts to study them. This second point 

is of critical importance to any discussion of meaning. To analyze the semiotic content of 

glyphs, we must first establish and delineate in a scientific manner the actual boundaries 

of human manipulation on a stone. At many sites, the ambiguity of markings exacerbates 

interpretational division. Authors disagree over the actual composition of the petroglyphs 

and from these divergent starting points arrive at increasingly disparate interpretations. 

Archaeologists are now more actively seeking out and documenting sites, and in 

doing so they are applying new technologies to the task. The recent use of three-

dimensional scanning represents one of the most promising developments in many 

years for the objective baseline documentation of these features. Armed with advanced 

equipment like laser scanners, archaeologists daily capture millions upon millions of 

points of three-dimensional data. Ultra-precise and hyper-accurate, these tools generate 

data-rich recordings of surfaces, often paired with high resolution imagery, all in a neatly 

packaged container. However, even with impressive 3D models allowing us to study 

petroglyph sites from the comfort of our labs, the way in which we represent the 

petroglyphs themselves has changed little. Whether by freehand sketching in the field or 

digital tracing in the lab, common procedures for representing petroglyph content are still 

rife with subjectivity and tedious manual differentiation. Despite the growing prevalence 

of 3D scanning in the documentation of rock markings, still absent are established 
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methods for realizing the full potential of this data. I perceive then a clear gap in existing 

knowledge which may be remedied by this study, or more aptly by the product of this 

study: a simple, effective, and objective process for visualizing petroglyphs. The 

development of such a process also offers an opportunity for its inauguration on a 

dataset primarily from the Eastern United States. With this small contribution I hope to 

attend to and moreover bring attention to a neglected region in rock marking scholarship. 

Statement of the Problem 

Archaeologists increasingly recognize and apply 3D recording of rock markings 

as a best practice in documenting and managing these sites. Yet, after the work is 

complete and the scanners stowed away, we often lack a route to making use of the 

data for answering basic questions about the extent and content of images on stone. 

Researchers still require a means for systematically, consistently, and objectively 

visualizing the petroglyphs found in these recordings. In the absence of clear evidence 

with which to make authoritative statements about petroglyph content, professional 

archaeologists are hampered in their efforts to combat the pseudoscientists, conspiracy 

theorists, and misguided avocationalists who bend these images to their will and 

implicate them in revisionist histories that disproportionately harm minority communities. 

There exists a clear need for a method which can leverage the potential of three-

dimensional spatial data in order to improve our knowledge and enhance our 

stewardship of such sites, as well as aid us in dispelling neocolonialist propaganda. 

Filling this need constitutes the primary purpose of this research. 

Research Design and Goals 

This study essentially engages in a form of evaluation research. It seeks to 

develop a new instrument which may be applied by researchers for the manipulation of 

three-dimensional data. More specifically, this instrument is a straightforward 

methodology for the colorization of petroglyphs in 3D modeling software. This work may 
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be best described as quasi-experimental: It attempts by trial and error to establish a 

cause-and-effect relationship between a series of operations and the visual contrast of 

petroglyphs in a 3D scan. By this means, it aims to develop, evaluate, and enhance the 

effectiveness of a process for achieving clear colorizations of images on stone. It also 

goes further in testing the developed approach on a regional dataset. The state of the 

field and nature of the subject however prevent the complete elimination of confounding 

variables. Similarly, trials could not be feasibly randomized. 

Individual trials were generally conducted according to a one-group pretest-

posttest research design, with the visibility of petroglyphs appraised before and after an 

intervention. These trials iteratively guided development to culminate in a process for 

maximizing petroglyph visibility. Appraising the ideal visualization of rock markings 

however is inherently subjective. This task is also not readily quantifiable; though a 

numerical category score could be applied to each visualization, this would only belie the 

qualitative nature of the data. Additionally, the routes to achieving visualizations 

traversed here produced customizable display ranges as opposed to singular images, 

and this complicates attempts at direct comparison of the results. Where possible, I 

temper this subjective assessment with comparison to what Seidl (2016:24) refers to as 

the ground truth: the expert manual segmentations generated by professional 

documentation of sites, which can help corroborate the markings revealed in this work. I 

hold the site plan or diagram, simultaneously depicting all anthropogenic features in their 

spatial and environmental context, as the ideal toward which we endeavor in working 

with 3D petroglyph data. 

Overview of Petroglyph Studies 

From some of the earliest colonial encounters in North America, Native American 

practices of pictorial communication and commemoration have attracted the attention of 

outside observers. Often, observers remarked upon rock markings in passing, as 
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curiosities, or tangentially in the context of some other purpose for writing (Beverley 

1705:44; Joutel 1714:164-165; Morse 1802:672-673; Hanna 1911:179; Galbreath 

1921:84-85). If and when they were recorded, it was frequently by freehand drawing that 

poorly reflected the reality of the imagery. The desire to accurately document rock 

markings grew in tandem with a fledgling preservation ethic during a period of salvage 

archaeology in the early twentieth century. The tools available for accurate 

documentation, however, had largely remained the same: sketching, tracing, frottage, 

and photography, the latter often preceded by the application of chalk for color contrast. 

Antiquarians involved in recovering the Bald Friar petroglyphs from the 

Susquehanna River had noticed in 1929 that chalking petroglyphs was fraught with 

error. Observers obtained variable results “in accordance with their varied opinions,” the 

cautious recording of some juxtaposed by the carefree approach of others (Anon. 

1929:7). Working with the limited evidence of now obliterated sites, researchers today 

often take for granted that photographers were even attempting to accurately portray the 

carvings in their images. Some, it seems, were more interested in a photograph they 

would be happy with: “Others have sought only to obtain pretty pictures, and to obtain 

effects have added to the outlines” (7). The recognized fidelity of taking impressions 

from stones is undoubtedly why Baer, Cadzow, and others went to the great pains of 

making casts of petroglyphs which could not be removed. Smith (1926) experimented 

early on with making cement casts of rock markings, which not only made more durable 

replicas but allowed for the imitation of the rock’s original color and texture by changing 

cement composition. While this allowed for accurate documentation of a rockface as a 

whole, it did little to help delimit the markings themselves. 

Throughout the years this fundamental problem remained a constant thorn in the 

side of petroglyph scholarship. Steward (1937) recognized that rock-borne imagery, 

especially when highly eroded or abstract, proved extremely vulnerable to the 
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subjectivity of the observer. He enumerated the challenges in recording petroglyphs 

objectively, noting the mistaken identification of petroglyphs in natural features due to 

things like differential weathering, lichen growth, and peculiarities in the stone’s 

composition. More importantly, he remarks on the limitations of accurately documenting 

even genuine petroglyphs using current technology, as the necessity of chalking to 

create visible contrast for a photograph “introduces a real possibility that the person will 

chalk so as to idealize…One tends to record what he thinks the petroglyph is intended to 

be, not what it really is” (1937:411). These difficulties exacerbated the interpretational 

malleability of images on stone, further enabling pseudoscientific claims and fringe 

archaeology. Steward lamented, “It is all too easy for a person bent on proving a thesis 

to read into [rock markings] whatever he desires and to find any shapes he seeks” (408). 

While practical technical limitations prevented the objective discernment of petroglyphs 

from natural rock, this was compounded by the absence of any real guidance on 

systematic recording procedures. 

Recognizing limitations in recording, scholars attempted to improve methods and 

critically sought to standardize data collection. Fenenga (1949:2), inspired by Steward’s 

systematic treatment of the topic, offered a form “designed to facilitate the complete and 

accurate recording of data” by standardizing criteria and categories and setting a 

minimum level of information to collect. It also prescribes the collection of necessary 

supplementary material, and Fenenga details steps and best practices for 

photographing, sketching, and tracing petroglyphs (4-5). Later authors proposed 

minimum recording standards according to explicit criteria. The American Committee to 

Advance the Study of Petroglyphs and Pictographs was formed in 1979 and, 

synthesizing the expertise of its roughly eighty members, weighed in on best practices 

for recording rock markings (Swartz 1980, 1981). Though unable to universally condone 

any one recording method due to the highly contextual nature of this judgment, they 
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disavowed chalking in any form and cautioned about the negative impacts recording can 

have on sites. At the same time, there were limits to the practical utility of their guidance. 

The committee assumed the average archaeologist would have the knowledge 

and expertise to distinguish the minute differences in “wear surfaces” (i.e., different 

manners of petroglyph and pictograph creation) and “superpositions” (i.e., the placement 

of rock markings over one another) (1981:94). While apparently a simple task, 

accurately identifying the superpositional order of markings is often deceptively complex. 

Some of the committee’s instructions are certainly easier said than done, such as the 

imperative to “avoid interpretive preconceptions” (95). Various scholars (Bain 1971; 

Clewlow and Wheeling 1978; Loendorf, Olson, and Conner 1988; Sanger and Meighan 

1990; Bock and Bock 1991; Loendorf et al. 1998) answered the deficit of practical 

resources with detailed recording manuals for rock markings. While archaeologists 

sought to standardize and set expectations for recording, the methods of recording at 

their disposal remained largely the same. Researchers still lacked tools to enhance 

petroglyph visualizations, while basic theoretical issues like the subjectivity of the 

recording process went unresolved. 

In the early 2000s, new techniques arrived on the scene. With the maturation of 

the personal computer, some were quick to seize upon the potential applications to 

archaeology. The digital enhancement of photographs in particular shone as a method of 

making rock markings more visible while crucially allowing this work to take place in the 

lab rather than the field. With their sensitivity to color manipulation, pictographs were 

often subjected to this treatment (David et al. 2001). Clogg, Díaz-Andreu, and Larkman 

(2000) used a threshold filter to create binary images separating paintings from their 

background. Almost two decades later, Wang et al. (2019) apply an essentially similar 

process to good effect. Yet the digital enhancement of pictographs may have reached its 

apex in Harman’s (2005) decorrelation stretch software (DStretch), which has become 
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an industry standard tool for enhancing highly eroded rock paintings (McDonald et al. 

2016; Simek et al. 2019). Work on further enhancing pictograph visualizations continues, 

such as in the application of multispectral imaging (Fredlund and Sundstrom 2007; 

Pereira Uzal 2015; Zainuddin et al. 2019) and other tools (Andrews and Brink 2022) 

alongside DStretch. Though these methods are sometimes applied to petroglyphs, they 

are generally not effective. Charles, Castilla, and Bodenstein (2022) have even called for 

portable particle accelerators to be applied to the study of rock markings and suggest 

paths for the development of such a device based around Particle Induced X-ray 

Emission (PIXE). They report that elemental mapping of the kind that revealed hidden 

portraits in the works of Van Gogh and Degas might offer a way of seeing pictographs 

which exist only in trace amounts or are obfuscated by fouling like graffiti and dust. 

Work with petroglyphs has taken a slightly different route. Around the same time 

that digital image enhancement began gaining traction, early applications of 3D 

recording also appeared. Cooper (2000) demonstrated the utility of photogrammetry in 

cooperation with digital representation, producing not only digital outlines of petroglyphs 

but also colorized contour models of the three-dimensional data they generated. Darvill 

et al. (2000) likewise digitally traced petroglyphs after recording sites with 

photogrammetry and laser scanning. Since the inception of 3D scanning, it has been 

applied to recording rock-borne imagery with increasing frequency. While there are a few 

ways of capturing three-dimensional data, documentation through laser scanning 

(Doering and Collins 2012, 2013; Kirk 2013), photogrammetry (Simpson et al. 2004; 

Rowan and Hill 2014), or both (Riveiro et al. 2011) remain the most popular options. Yet, 

despite the 3D character of the new datasets being generated, the way that petroglyphs 

are depicted has remained largely the same: manual delineation. For example, Landon 

and Seales (2006) made use of the interactive lighting parameters available in a 3D 
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simulated environment, but still ultimately used this to inform the manual highlighting of 

the glyphs they perceived. 

While the complementary integration of digital drawing and 3D data has a place 

in archaeology more broadly (Kimball 2016), I question whether continuing the manual 

creation of 2D drawings from 3D datasets (Urcia et al. 2018) truly realizes the potential 

of this technology. I do not intend to single out any one researcher, for this behavior is 

not limited to an individual. Even the most revered academics in this field are prone to 

dutifully collecting 3D data, only to make simple, subjective digital drawings from it 

(Simek, Alvarez, and Cressler 2022). Of course, any well-researched, productive 

petroglyph scholarship is to be encouraged; but we may still seek a better path. Lee and 

Hyder (2009) have discussed additionally the fallibility of tracing from photographs, 

advocating careful and time-consuming manual recording directly at the site. Of course, 

Steward’s ghost will attest that this is not the panacea we seek. 

Bai et al. (2023) have achieved impressive segmentation of petroglyphs without 

3D data at all, instead using a Gaussian loss algorithm for machine learning on high 

resolution images. Seidl (2016:49-65) previously applied an automatic segmentation 

algorithm to photographs of petroglyphs, approaching the problem as pixel classification. 

Seidl pointed out, however, a key issue with the use of images which is just as 

applicable to Bai et al.: they are left at the mercy of their lighting. He writes that “the main 

disadvantage of using photos for segmentation is the dependency on the lighting 

situation during acquisition” (6). The appearance of petroglyphs can vary greatly 

depending on direction and intensity of lighting, and this is another reason to critique all 

of the aforementioned studies which use imagery as the primary basis for delineating 

rock markings. 

In contrast, some scholars lean heavily into the complete command of lighting 

offered by 3D modelling software as a means of avoiding this problem. Zachar (2017) 
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gives a detailed explanation of the use of different shaders with 3D models for the 

visualization of detail on cultural resources. Some of the most common shading 

techniques include ambient occlusion and radiance scaling, often in unison with basic 

shading lighting. Ambient occlusion simulates general illumination and essentially 

replicates the shadowing caused by parts of an object blocking ambient light (2017:91). 

Radiance scaling is adept at revealing concavities and convexities as it modifies light 

intensities to correlate with surface feature variations (90). Vilas-Estevez, Vázquez-

Martínez, and Carrero-Pazos (2016) specifically applied radiance scaling as an 

alternative to traditional petroglyph tracing, arguing that it improved both visibility and 

objectivity. Mark and Billo (2021) have reiterated the usefulness of this lighting 

technique. 

Others have implemented these methods into workflows for generating pseudo-

traditional tracings by applying automatic vectorization to images made with radiance 

scaling (Gil-Docampo, Peña-Villasenín, and Ortiz-Sanz 2020). It is no surprise then that 

Valdez-Tullett and Figueiredo Persson (2023:14) recently described radiance scaling as 

“one of the most popular rendering options for rock art visualization due to its potential to 

clearly and easily enhance depth variations, concavities and convexities across a 3D 

model.” Though attempting to make better use of the models as something other than 

proxies for firsthand observation, these studies still ultimately limit themselves to the 

visual appearance of the stone. That is, while freeing themselves from the mercy of 

natural lighting conditions, they remain constrained by what light can do, even in a virtual 

environment. 

Many have thus followed the flawed but familiar models of traditional recording 

methods, changing only the medium of their tracing and sketching. A growing number 

have exploited their ability to control the virtual environment, but few have unlocked the 

real power of topography in engaging with this data. Ironically, a breakthrough appeared 
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early on with the application of methods from GIS frequently used in landscape 

archaeology. Trinks et al. (2005) essentially convert a 3D model of a stone bearing 

petroglyphs into a Digital Elevation Model (DEM). The color at a given point is thus not 

assigned by lighting conditions (real or virtual) but by a quantifiable elevation value over 

a hypothetical plane. What makes this contribution even more significant is their 

development of a means for showing local surface variation. Trinks et al. realized that 

the extreme curvature of some rocks made the overall elevation poorly suited to show 

petroglyph details. By homing in on the small variations at the surface level, better 

visualizations could be achieved. They offer an explanation of their method: 

 “The local (or relative) elevation…may be achieved by applying a spatial high-
pass frequency filter to the 3D point data and removing the low frequency (long-
wavelength) curvature of the natural rock surface, thereby flattening the model of 
the rock artificially. The surface may then be coloured according to elevation... 
since the remaining elevation differences are solely due to the short-wavelength, 
artificial markings or natural fissures in the rock surface.” (2005:136) 

One strength of this approach is that the only subjective input of the researcher is their 

control over the color scale parameters when selecting the upper and lower limits of the 

colorization. The other, more obvious strength is the exceptional visualization achieved. 

This method surprisingly has not proliferated despite its effectiveness and unassailable 

objectivity. Brink (2007:89-92) does similarly measure distance against a hypothetical 

flat plane to create a colorization of replica petroglyphs, but settles for colorizing global 

elevation, perhaps due to the stone already being relatively flat. 

Jalandoni and Kottermair (2018:585) have carried on the use of GIS tools for 

visualizing petroglyphs but take a different approach. They generated a DEM from their 

3D model and then applied a hillshade effect to help visualize the markings. They found 

however that the hillshade created an unacceptable bias due to the artificial illumination 

angle. This same critique can be levelled at practically any use of real or artificial 

shading to segment petroglyphs. Their more promising innovation is their approach to 



13 

capturing local elevation by way of a topographic position index (TPI) algorithm, which 

operates thus: 

“The TPI compares the elevation of each pixel of a DEM to the mean elevation of 
pixels in a specific surrounding area, providing a relative position...a TPI is 
commonly used to classify a landscape into valleys, slopes, and ridges or to 
detect anomalies such as depressions...” (581) 

The TPI algorithm can be applied through a simple tool in ArcMap, and with it Jalandoni 

and Kottermair were able to identify almost twice the number of engravings compared to 

manual tracing, as well as correct inaccuracies in the latter. Jalandoni and Taçon (2018) 

apply these same methods with equal success. 

Other experimental uses of algorithms for enhancing petroglyphs appear 

arguably less successful. Wojcicki, Korga, and Milosz (2022) developed an algorithm 

which takes cross-sections of the point cloud and progressively removes extreme points 

to reveal anthropogenic depressions. At this stage in their research, however, the 

product is visibly inferior to other enhancement methods covered. In response to his 

critiques of segmentation algorithms using images of petroglyphs, Seidl (2016:67-83) 

also attempted the automated segmentation of petroglyphs based on 3D properties. A 

computational representation of a given point is extracted based on the point’s 

neighborhood, following a set rule, and these representations are then compared to 

identify similarities and, ultimately, to classify them. This classification was done by 

machine learning and classified points as either engraved or natural rock surface. The 

technical nature of Seidl’s work is difficult to describe and I likely oversimplify it. In any 

case, Seidl found that segmentation of petroglyphs by this 3D descriptor-based method 

was prone to false positives and performed much worse than expected despite 

excessive computation times. 

Seidl’s work instead achieved its best segmentation when the machine 

classification used an image-space approach with an “enhanced depth map” (2016:75-
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76). The process for making this enhanced depth map is outlined in Zeppelzauer and 

Seidl (2015) and has since been applied in Horn, Pitman, and Potter (2019) and Horn et 

al. (2022). Besides Jalandoni and Kottermair’s use of TPI, this colorization process is 

probably the most successful method currently being applied to the problem of 

petroglyph visualization. This success is not entirely shocking, since the process is 

identical in premise to the aforementioned method outlined by Trinks et al. (2005). In 

Zeppelzauer and Seidl’s revision, they simply smooth a depth map “by convolution with 

a two-dimensional Gaussian-shaped filter” to approximate the global curvature and then 

subtract this from the original to see the microtopography in what they refer to as a 

“compensated depth map” (2015:2846). This is what Trinks et al. refer to as a relative 

elevation model. Horn et al. (2019:4) borrow from landscape archaeology in referring to 

this method as “local relief modelling (LRM),” but the process is the same. Horn et al.’s 

(2022) major contribution is the packaging of this technique in a simple software, 

Ratopoviz (Rock Art Topographic Visualization). I discuss this software in greater detail 

in the next chapter. 

Beyond these studies there have been few other routes explored for improving 

glyph visibility. Mark (2017) outlined a “digital rubbing” method that is thankfully less 

traditional than it sounds, using Poisson Reconstruction on a point cloud to create a 

contrasting visualization against the backdrop of the original mesh. DeGayner, 

Rodriguez, and Moss (2019) describe a unique process involving the manual selection 

of points to create “a faceted surface that generally approximates what the surface 

would have looked like prior the creation of the petroglyph” (2019:40). They then run an 

algorithm to calculate the difference between their simulated, pristine rockface and the 

actual scan. These last two works offer a point of departure for my own research as I 

seek to make use of the latent potential of 3D petroglyph data. Together with popular 

shading filters like radiance scaling and the promising method originating with Trinks et 
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al., we have the raw material for a survey of existing colorization strategies and a 

starting point for further experimentation. Moreover, we have an opportunity to explore 

some of these state-of-the-art approaches with petroglyphs of the eastern United States, 

where this work has not been applied. 
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Chapter 2: Experimentation and Results 

The following section of this work discusses experiments conducted in the 

development of a methodology, results of the experiments, and brief analysis of those 

results. While somewhat unconventional, the choice to combine these discussions came 

organically consequent the iterative nature of the work, which caused these 

conversations to become inextricably intertwined. Since the aim was to develop, by trial 

and error, archaeological methods and workflows for the analysis of three-dimensional 

petroglyph data, the manner of conducting each trial and the product obtained informed 

the methods used in subsequent trials. Moreover, it appeared necessary to address the 

many possible combinations and substitutions of steps in the production of a streamlined 

process. This was especially true with regard to conducting a cost-benefit analysis of 

alternative methods which resulted in similar products. 

Recognizing also the widely variable needs of researchers working in many 

different contexts, it became important to offer for consideration any method which 

proved productive. Indeed, as many different procedures generated encouraging results, 

the research question shifted. Rather than identifying a singular, superior process, the 

task evolved into identifying what processes best suited specific contexts. Of the many 

workable combinations of procedures, in what settings did some combinations 

particularly excel? Where two options initially produced the same results, did they lead to 

any divergence in the final product after other steps had been applied? Where the final 

products were the same, could one combination of steps result in an overall more 

efficient or less resource-intensive workflow? These factors thus complicated a 

compartmentalized organizational scheme, which by truncating these discussions would 

belie their interconnectivity. 

This work employed diverse three-dimensional datasets in terms of geographical 

distribution of sites, data quality, and file format. More specifically, the datasets 
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consisted of 3D point clouds and point clouds with associated meshes in .ply, .obj, and 

.stl formats which were generated by TLS and photogrammetry. The petroglyph sites 

represented in these files are CHOH-3 and CHOH-26 (or by its state trinomial, 

18MO0134) of the Chesapeake and Ohio Canal National Historical Park, the Pimmit Run 

Petroglyph (44FX3079) of the George Washington Memorial Parkway, the Octoraro 

Creek Petroglyphs (18CE0398), Dighton Rock (BRK.902), and Judaculla Rock 

(31JK0003). The high-resolution 3D models of the CHOH and GWMP petroglyphs and 

the scans from which they are derived were created by a team from the University of 

South Florida using a Surphaser 25HSX laser scanner for sub-millimeter accurate 

recording (Doering and Collins 2012; 2013). The remaining files are publicly available 

online and are more variable in their resolution and accuracy. 

The model of a boulder bearing petroglyphs from Octoraro Creek and two scans 

of Judaculla Rock were found submitted by their various creators to a community-based, 

3D model webhosting service called Sketchfab. While found hosted on the website of a 

frequently pseudoscientific avocational archaeology group, the partial scan of Dighton 

Rock was originally produced in 2015 by Stephen Wilkes, former Director of 3D Services 

and current Chief Innovation Officer at Feldman Geospatial, a reputable land surveying 

company. Regardless of who created it, sourcing data from pseudoscientists elicits 

reasonable concern about validity and provenience. This predicament, however, 

highlights an unfortunately frequent issue in petroglyph research: neglected by 

professional archaeology, valuable data is instead gathered or hosted by enthusiasts 

who at times occupy fringe positions. Out of necessity, archaeologists employ the work 

of and even at times ally themselves with these groups and risk legitimizing unscientific 

interpretations. The decision to include such data was therefore carefully weighed 

against the potential research benefits. 
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With regard to how detailed the 3D models are, the juxtaposition between 

meshes is made apparent in Table 1, which gives a summary of the files involved in this 

investigation and some of their relevant statistics. All of these files are 3D models with 

associated point clouds. The point clouds can be thought of as a raw material created 

during the scanning process, consisting of a ‘cloud’ of points in space. What we call a 3D 

model is a mesh created from these points. This mesh is a solid surface made up of 

triangles, with each of the triangles formed by grouping three points. In their role creating 

the triangles and thus the geometry of a mesh, these points are called vertices. A key 

consideration for working with rock markings then is not only the accuracy of each point 

recorded (i.e., how trustworthy is the scanner’s measurement) but also the number of 

points recorded, since fewer points mean larger gaps in our information about a surface, 

fewer triangles to reconstruct that surface, and thus less detailed reconstructions. 

While file size and the number of vertices and triangles are generally good 

indicators of the resolution of the scan, a perhaps more useful metric would be the point 

density relative to actual square footage of rock represented. This would offer a 

comparable statistic for appraising the quality of large and small area scans, which must 

be considered in concert with measurement accuracy. It was initially not feasible to 

provide such a metric here, however, given limited site documentation and uncertainties 

in the conversion of 3D model distances to a real-world unit of measurement. In any 

case, the compiled dataset offered a range of precision levels to experiment with, 

including two scans from the same site with a striking contrast in recording specificity. A 

mesh may also have a texture attached to it, referred to in the table as a ‘skin,’ which is 

simply an image that is mapped onto the mesh surface. Most of the meshes used here 

include a texture, giving us photorealistic representations of the glyphs. Many 3D 

scanners today include high definition image capture and texture creation as a standard 

part of the recording process. 
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While still becoming acquainted with the selected datasets and developing a 

familiarity with 3D modeling software, the author fortuitously stumbled upon a relevant 

project conducted for Pecos National Park which was detailed in a post to the park’s 

social media. Archaeologists for the park had recorded a petroglyph panel using 

structured-light 3D scanning methods and then manipulated the resulting 3D model so 

as to enhance the petroglyphs’ visibility. This work was previously published in 

Archaeology Southwest (DeGayner, Rodriguez, and Moss 2019) but the particular 

details of the enhancement process are omitted. After an inquiry to Pecos National Park, 

I received more details from the archaeologists involved (DeGayner and Moss 2022, 

pers. comm.), who graciously outlined their exact process. DeGayner described their 

methodology thus: 

“1. Define points on the surrounding bedrock that do not appear to be recessed 
as a result of creating the glyph. This process is somewhat subjective, but the 
more points you create, the better the approximation of the original unaltered 
surface will be. 
2. Create a mesh surface using these points. You can think of this as a low-
resolution model of the original unaltered surface. 
3. Run a distance computation process against the scanned model and the mesh 
from Step 2 [.…] 
4. Adjust color ramp [of scalar field] to achieve optimal visualization of the glyph 
depths.” 

DeGayner reports using a free program called CloudCompare to complete this work, but 

notes that “many other scanning-oriented software platforms” are equally capable of 

performing these operations. He also recommends one such program, called MeshLab, 

for the use of built-in shaders which can be easily applied and reveal minute details on 

surfaces. I had been using MeshLab and experimenting with these shaders prior to 

being introduced to the CloudCompare program, and will briefly describe my findings 

before returning to DeGayner’s method. 

In contrast to CloudCompare, I found MeshLab highly responsive when 

maneuvering meshes of all sizes without ‘stuttering’ or lagging. Combined with its 
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lighting controls, MeshLab proves extremely useful for close, preliminary investigation of 

a rock surface. While in CloudCompare users can also achieve fine control of lighting 

with the custom light (toggled with F7), the controls for doing so are not as smooth. In 

CloudCompare, the user must hold CTRL+right click to drag the light source to a 

different position; otherwise, the light source will rotate with the mesh itself. In MeshLab 

on the other hand, the light source will by default stay in a fixed position independent of 

mesh rotation, which is done simply by left clicking and dragging. Manipulating shading 

in this manner feels quite intuitive, akin to angling a worn coin in the light to make out 

faint lines. The user can therefore tease out small or eroded glyph details by applying 

different lighting angles with greater ease and fluidity. 

Moreover, lighting can still be repositioned while the mesh remains static, as in 

CloudCompare, and this can be useful for taking a series of screenshots from a 

consistent viewpoint but different lighting angles. The controls and feedback to the user 

are improved in MeshLab, however: CTRL+shift+left click and drag moves the single 

light position, and gives a series of parallel lines illustrating the exact orientation of the 

light source. In CloudCompare, the source of the light is not as clearly indicated. In 

Figure 1: 3D light positioning comparison. Whereas light source positioning is indicated 
with a small yellow plus symbol that is easily lost in CloudCompare (right), it is 
intuitively and clearly illustrated with parallel ‘light rays’ in MeshLab (left). 
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summary, for achieving the seamless movement of a light source to inspect the 

characteristics of a surface, as in an RTI viewer, MeshLab offers a more fluid and user-

friendly experience. 

Shaders are, in layman’s terms, preconfigured instructions for how light, shadow, 

and color should interact with the surface of an object. The information about the object 

is rendered into a visual representation according to these instructions. The potential 

implications of controlling these factors for visualizing petroglyphs are obvious. With a 

mesh opened in MeshLab, shaders can be applied by accessing the toolbar and 

following the path Render>Shaders. From here a drop-down list offers a default of 

twenty different shaders. Many of the shaders themselves are somewhat lackluster, 

however. While the shaders can be quite useful for acquainting oneself with the surface 

of the mesh and to some degree for outlining glyphs in binary color, they offer little in the 

way of advancing objectivity. Moreover, to the uninitiated the plethora of shaders, lacking 

description of their function, can act as a hindrance rather than help. While some appear 

to enhance glyph legibility, it tends to detract from our confidence in the results if the 

researcher cannot explain how or why a specific shader improved visibility, much less 

what the shader does. 

Nonetheless, shaders can be quickly applied and some stood out as useful 

additions to our toolkit. Good results came from applying the radiance scaling shader 

(Figs. 3-4), especially with its ability to inverse its results. This gave similar outlining to 

more complicated procedures later done with CloudCompare. Some shaders were more 

useful when applied in unconvential ways. The effect created by the dimple shader, for 

example, is not desirable; however, with dimpling effectively turned off the shader 

becomes useful as a simple way of reproducably quantifying adjustments to the light 

source position (Fig. 5). Other shaders offer the same means of adjusting light position 

and can be helpful when used as intended (Fig. 6). 
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Figure 2 (top): Shader selection in 
MeshLab 
 
 
 
Figure 3 (middle): Radiance 
scaling shader (Grey Descriptor) 
applied to CHOH-26. Note 
previously unidentified carving to 
the left of the concentric 
diamonds. 

Figure 4 (bottom): 
Radiance scaling 
shader (Lambertian) 
applied to CHOH-26, 
viewed from an oblique 
angle with lighting from 
below 
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Figure 5: Three views of CHOH-26 with the dimple shader used to precisely set 
unique light source positions; the dimpling effect itself has been turned off. 
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Exploring MeshLab’s capabilities also introduced me to options for colorizing 

mesh curvature, and these appeared more promising than shaders as a route to 

developing objective research methodologies. I was particularly impressed with the 

algebraic point set surfaces (APSS) variant of the ‘Colorize Curvature’ filter (Fig. 7). 

Preconfigured shaders and manual manipulation of shading prove inherently sensitive to 

small changes in lighting-to-mesh position, and they can rarely elicit all of the details of a 

rock carving simultaneously. Moreover, these strategies can rarely be extended for 

comparable results elsewhere, since the specific lighting angles that make carvings most 

apparent are highly specific to each petroglyph site. Non-shading based colorization 

methods, in contrast, reify the information ingrained in the mesh (e.g., the curvature of 

the triangles, the relationships between points, their distance to an imaginary plane, etc.) 

independent of lighting conditions, doing so in a repeatable manner that can be 

standardized across datasets. 

Figure 6: Glass shader applied to CHOH-26. The light source can be adjusted via 
the LightPosition setting as with the dimple shader. Unlike the dimpling effect of the 
latter, however, the ‘glass’ effect can be potentially useful in its own right for 
improving rock marking visibility. 
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Figures 9-11 show the APSS filter applied with the same settings (Fig. 8) to 

three petroglyph sites. Different visualizations can be achieved by adjusting the filter 

settings. Inputting different filter parameters sometimes further accentuated the details of 

the carvings; overall, however, this tool and others like it did not achieve much greater 

clarity than what has been pictured. Furthermore, these filters took some time to process 

and required significant computational resources. I therefore sought an improved 

approach which would similarly eschew reliance on shading and enable standardization 

while increasing speed, performance, and petroglyph discernment. 

 

The CloudCompare software and process suggested by DeGayner served as a 

point of departure for developing a refined approach. Applying the steps enumerated by 

DeGayner to CHOH-26 (Fig. 12), I began by selecting points that did not appear to be 

recessed by human activity. As DeGayner mentions, this process is somewhat 

subjective, but I found it easier to distinguish the raised areas of unaltered stone by 

turning off the material texture and instead viewing the mesh as a solid color (light gray) 

that contrasted well with normals shading (Fig. 13). I then used the Point List Picking  

Figure 7: Location of the ‘Colorize Curvature’ (APSS) filter 
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(Counterclock-
wise from top 
right): 
 
Figure 8: APSS 
filter settings 
applied to the 
3D models in 
Figs. 9-11 
 
Figure 9: 
Octoraro Creek 
petroglyphs with 
colorized 
curvature 
 
Figure 10: 
Dighton Rock 
with colorized 
curvature 
 
Figure 11: 
CHOH-26 with 
colorized 
curvature 
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tool to sample a total of 541 points where the rock appeared unaltered, taking care to get 

a good selection of points around areas that had been heavily worked (Fig. 14). This 

produced a PickingList of the selected points, which I then exported to a new point cloud 

by selecting “new cloud” from a drop-down list of options for saving the PickingList (Fig. 

15). The resulting cloud is pictured in Figure 16. 

Proceeding to DeGayner’s second step, there are a few methods of generating a 

mesh from this new point cloud, and I employed three in testing. The first two are 

through the mesh tool (Edit>Mesh) and apply Delaunay triangulation to the point cloud. 

The first option, Delaunay 2.5D (XY Plane), projects the point cloud in two dimensions 

onto the XY plane prior to applying triangulation and translating this triangulation back 

into three-dimensional space. This mesh was therefore immediately eliminated since it 

only produces usable results when the cloud has been properly oriented to the Z-axis. 

The second option, Delaunay 2.5D (best fitting plane), works the same way but without 

relying on any prior orientation of the cloud, as it projects instead onto a plane fit to the 

cloud itself. The other tool used was the Poisson Surface Reconstruction 

(PoissonRecon) plugin. In perhaps oversimplified terms, this plugin poses mesh 

reconstruction as a mathematical Poisson problem: the location of the points and their 

orientation are included in the problem, and the reconstructed mesh is the function that 

Figure 12 (left): CHOH-26 with material texture (or ‘skin’) and normals 
Figure 13 (right): CHOH-26 with normals only 
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Figure 14 (top): CHOH-26 with 
points of unaltered stone selected 
as a sample. 
 
Figure 15 (middle): Creating a new 
cloud from PickingList. 
 
Figure 16 (bottom): CHOH-26 
sampled points exported as a new 
point cloud. 
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best solves this problem (Kazhdan, Bolitho, and Hoppe 2006). Though the meshes 

made using Delaunay 2.5D (best fitting plane) (Fig. 17a) and PoissonRecon (Fig. 18a) 

both performed well in succeeding steps, Delaunay may be preferable given the 

tendency for PoissonRecon to fill the entire bounding box when it generates a mesh. 

Using the two successful meshes I proceeded to DeGayner’s third step and 

performed a total of four colorizations by distance computation. Selecting the original, 

unaltered and unsampled cloud for CHOH-26 and the Delaunay reconstructed mesh, I 

applied the “Compute Cloud/Mesh Distance” tool to perform the first distance 

computation, resulting in a colorized scalar field (Fig. 17b). I repeated these steps for 

the second distance computation against the PoissonRecon mesh (Fig. 18b). I 

performed two more distance computations to evaluate potential improvements to the 

colorization. In the first (Fig. 19b), the mesh generated using Delaunay 2.5D (best fitting 

plane) was smoothed using Laplacian smoothing prior to the distance computation (Fig. 

19a). Smoothing by twenty iterations at a smoothing factor of 0.2 helped level the 

extreme points of this low-resolution mesh, and I hypothesized that this might help to 

negate any skew introduced by preconceptual bias in point selection. 

In the second distance computation (Fig. 20), the original point cloud for CHOH-

26 was trimmed to the area of our Delaunay 2.5D (best fitting plane) mesh so as to 

remove the noise introduced by points that were not reconstructed (i.e., points in the 

unaltered cloud that had no comparand in our low-resolution mesh). I hypothesized that 

this would allow us to more finely tune the scalar field and thereby elicit finer details. For 

all of the aforementioned computations, as well as later ones, I made certain to select 

the original cloud (or a copy of it) as the ‘Compared,’ while the downsampled mesh, 

cloud, or flat plane that we create was selected as the ‘Reference’ (Fig. 21). This 

ensures that the scalar field produced by the Compute Distance tool is attached to the 

original, unaltered cloud and its associated mesh. Colorizations thus remain comparable 
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Figure 17: a) CHOH-26 mesh generated from point cloud in Fig. 16 using Delaunay 
2.5D (best fitting plane); b) Distance computed to the Master Cloud. 

Figure 18: a) CHOH-26 mesh generated from point cloud in Fig. 16 using 
PoissonRecon (Octree level 8); b) Distance computed to the Master Cloud. 

Figure 19: a) CHOH-26 mesh generated from point cloud in Fig. 16 using Delaunay 
2.5D (best fitting plane) after smoothing 20 iterations at 0.2 smoothing factor; b) 
Distance computed to the Master Cloud. 

a b 

a 

a b 

b 
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and undistorted by operations like smoothing of the low-resolution mesh, since the final 

product is solely a recolored clone of the original scan. 

 
The distance computation in Figure 17b against the Delaunay 2.5D (best fitting 

plane) mesh resulted in a particularly good colorization of glyph details, with clear 

distinction of the deeply incised areas and nuanced color variation showing faint details. 

This scalar field also shows consistent colorization up to the edges of the sampled point 

cloud since the reconstructed mesh (Fig. 17a) did not expand beyond the actual data 

Figure 20: CHOH-26, distance 
computed between mesh 
generated with Delaunay 2.5D 
(best fitting plane) [Fig. 17a] and 
the Master Cloud trimmed to the 
size of its comparand 

Figure 21: Selection of compared and reference entities. Selection is important for 
leaving the scalar field on the original, unaltered cloud and mesh. 
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points. The distance computation to the PoissonRecon mesh (Fig. 18b) produced 

decent results which are largely similar to the colorization in Figure 17b. However, while 

there appear to be no perceptible improvements in the details revealed, there are clear 

areas of obfuscation compared to the previous computation. Particularly at the edges of 

the colorized areas, large blotches of solid color obscure details which were clearly 

visible in Figure 17b, and this is attributable to the extension of the PoissonRecon 

reconstruction beyond the sampled point cloud. In fitting the reconstructed mesh to the 

bounding box rather than the limits of the 541 sampled points, the PoissonRecon mesh 

fills in areas of no data at its edges. PoissonRecon also by default allows the 

reconstructed mesh to exclude points (Fig. 22) unless adjustments are made in the 

‘Advanced Settings’ tab, and even then the results are far from ideal. 

Together these problems create an inaccurate approximation of the curvature of 

the rock, leading to greater discrepancies in the distance computation at the edges of 

the reconstructed mesh and thus distortion or loss of detail. The colorization (Fig. 19b) 

resulting from first smoothing the Delaunay mesh before computing distance apparently 

offered no benefit; the result was clearly an inferior colorization, being a ‘fuzzier’ version 

of the colorization in Figure 17b. It is worth noting, however, that this does not 

necessarily invalidate the usefulness of this method elsewhere. I suggest later that 

smoothing is an important step, but one ill-suited to the low-resolution mesh generated 

from such a sparse point cloud (541 points being quite a small sample relative to the 

millions of points comprising some scans). In Figure 20 on the other hand, we see a 

more positive if not drastic difference from Figure 17b. Segmenting the original cloud to 

the bounds of the reproduced mesh did offer better control over scalar field adjustments. 

Irrelevant points from the original cloud which lacked a comparand in our simulated, 

unaltered rockface were removed and thus did not skew the colorization. The greater 

ease of scalar field adjustments is visible in the greater width of the scalar field display 



34 

parameter chart. Otherwise, there is no difference, and the accessibility of adjustments 

to the colorization is the only benefit. I conclude on the basis of simplicity, repeatability, 

and quality of colorization that a simple distance computation (Fig. 17b) to a Delaunay 

2.5 (best fitting plane) mesh (Fig. 17a) presents the optimal choice when following 

DeGayner’s process. 

 
Having established a clear and effective sequence of steps, I sought to refine or 

rework them. Even with the 541 points we manually selected to use in our mesh, the 

divergence of our simulated ‘pristine’ rockface from reality lead to many natural features 

appearing in the colorization. As DeGayner noted regarding the simulation of a stone 

prior to petroglyph creation, “the more points you create, the better the approximation of 

the original unaltered surface will be.” Taking this premise to its logical conclusion, the 

ideal form of this process would involve selecting every single point where the stone is 

unaltered and excluding every single point evincing human action. That is, we would 

achieve a perfect manual segmentation separating anthropogenic and natural features. 

Figure 22: PoissonRecon reconstructed mesh, showing sampled points which were 
excluded by the plugin. 
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An obvious bottleneck occurs in the process if the researcher manually selects, 

point by point, what can amount to thousands if not millions of points. One potential 

solution appears in pivoting instead to exclusion of points: rather than manually picking 

points for our simulacrum, we clone the point cloud and manually remove the points 

showing evidence of carving, pecking, or the like. This is feasible since the markings 

themselves tend to comprise only a fraction of the surface area of a rock, and points can 

quickly and easily be segmented and deleted in CloudCompare. The result is a new 

point cloud which is denser by magnitudes compared to the measly 541 points we 

selected for inclusion previously. I hypothesized that the areas in which the point cloud is 

fully retained would appear as a solid color since the distance computation would return 

zero values. 

I enacted the alternative sampling method. Figure 23a shows the removal of 

some – but not all – carved areas from a clone of the CHOH-26 mesh. Numerous 

obvious areas of incising were not segmented out as a sort of control, in order to see if 

they would also become visible or disappear into the background. Figure 23b shows the 

resulting mesh reconstructed with Delaunay 2.5D (best fitting plane). Finally, Figure 24a 

shows the colorization pursuant a distance computation between the original cloud and 

the mesh in Figure 23b. I regard this colorization as a failure, and its failure illustrates a 

key theoretical failing in the process. Its flaw stems from two unanswered questions: 

Does the manual selection of the point cloud perceptibly skew the colorization, and is the 

presence of distortion influenced by the percentage of the original point cloud we 

sample? 

The reconstruction of the mesh in this manner guarantees, as hypothesized, that 

our distance computation will only return different values in the areas that have been 

segmented out. That is, the only highlighted areas are the areas we cut out of the scan. 

This would be acceptable if our manual segmentation of the culturally modified areas 
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was perfect, but it is not. Indeed, the entire purpose of the colorization is to make clear 

the details that we cannot see or only perceive with difficulty. Not only do our control 

areas of known incising become invisible, but the rough segmentation I performed 

commands the colorization. Note, for example, the odd curvature of the fork situated 

above the nested diamonds in Figure 24a; the colorization follows my imperfect cutout 

rather than the reality of the carving, which is more of a perfect ‘Y’ shape (cf. the same 

area in Figure 20). We may deduce that part of the reason that taking DeGayner’s 

method to its logical conclusion fails is because, in his original method, the extremely 

low resolution of the mesh significantly mitigated the bias in our selection while doing the 

‘heavy lifting’ in the colorization. The mediating role of the downscaling is illustrated in 

Figures 24b-d, which show the same colorization performed in Figure 24a but with 

progressive smoothing of the mesh prior to computing distance. As the smoothness of 

the mesh is increased, the real details of the carvings begin to appear regardless of our 

segmentation. 

  

Figure 23: a) DeGayner revised method, mesh with segmented out material; b) 
DeGayner revised method, reconstructed mesh (best fitting plane) 

a b 
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Summarized in simple terms, the point selection process in DeGayner’s method 

plays only a small role in the method’s success. It may even be said that the method 

works in spite of the point selection process rather than because of it. What is really 

happening is that a person is unlikely to select but a small fraction of the overall points to 

create their own mesh. In the case of CHOH-26, we could manually select over 22,000 

points of apparently unaltered rock and still have selected only 1% of the points in the 

original point cloud. The mesh we reconstruct is thus of such a low resolution that our 

point selection does not significantly matter. What matters is that the global curvature of 

Figure 24: DeGayner revised method, distance computations with progressive 
increase in Laplacian smoothing of mesh in Fig. 23b; (clockwise from top left) no 
smoothing, some smoothing, more smoothing, most smoothing. 
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the stone has been captured in broad strokes, and thus this curvature is accounted for in 

the distance computation and effectively eliminated from the colorization. The product is 

a scalar field that colorizes the extreme values: high and low points, both natural and 

cultural. The creation of difference in the simulacrum is therefore essential to creating a 

decent colorization. This makes the number of sampled points a key concern since as 

more points are included, fewer differences exist to create a colorization. Specific choice 

of points is less important but can still skew the colorization – especially with higher point 

retention – by changing the distribution of difference. 

The relative insignificance of point selection in driving the colorization process is 

corroborated by an experiment illustrated in Figures 25-29. I roughly segmented a clone 

of the original mesh (Fig. 25) to the area covered in our first point selection process 

(Figs. 14-17). Then, I again selected 541 points from this bounded space, but this time 

by random subsample rather than meticulously selecting areas that appeared unaltered. 

I repeated this process three times for three different subsampled clouds comprised of 

541 points each (Figs. 26a, 27a, 28a). I then continued with DeGayner’s method as 

normal, generating meshes from these clouds (Figs. 26b, 27b, 28b) and lastly 

performing distance computations between the meshes and the master point cloud 

(Figs. 26c, 27c, 28c). The positive results seen in these colorizations evince the minor 

importance of manual point selection. The scalar fields created are on par with the ones 

we made through the careful, manual selection of unaltered points despite being 

selected completely at random. 

As the slight variations in our scalar fields show, however, randomness of the 

point selection is not entirely immaterial. I therefore thought to mitigate the issue by 

averaging the scalar fields we produced via scalar field calculations (Fig. 29), and this 

gave a clearly more consistent and accurate colorization. I conclude that replacing 

manual point selection with random subsampling of the point cloud provides a more 



39 

objective and systematic approach to colorizing three-dimensional petroglyph data, 

especially when conducted in multiple trials and the results are averaged. The random 

subsampling method requires no more effort and generally less time while offering 

results of comparable quality and superior objectivity. Yet, before forsaking manual point 

selection on these grounds alone, I also conducted another experiment aimed at 

appraising the danger of interpretive preconception in manually selecting points. 

 
 

Figure 25: Clone of CHOH-26 
mesh roughly segmented to the 
area covered by the previous 
point selection of 541 points. 

Figure 26: a) First random subsample of 541 points from area in Fig. 25; b) Mesh 
generated from point cloud in Fig. 26a; c) Resulting scalar field from distance 
computation between Fig. 26b and original mesh. 

a 

b c 
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Figure 27: a) Second random subsample of 541 points from area in Fig. 25; b) Mesh 
generated from point cloud in Fig. 27a; c) Resulting scalar field from distance 
computation between Fig. 27b and original mesh. 

Figure 28: a) Third random subsample of 541 points from area in Fig. 25; b) Mesh 
generated from point cloud in Fig. 28a; c) Resulting scalar field from distance 
computation between Fig. 28b and original mesh. 

a 

b 
c 

c 

a 

b 
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To determine the potential for misuse or inadvertent imposition of subjective 

interpretation onto the glyph content, I enacted a scenario in which a researcher is 

mistaken as to what they see. In this hypothetical setting, I pretended to see the word 

'hello' in the glyphs on Dighton Rock. I applied this misinterpretation to the selection of 

points for our simulacrum, generating a total of five meshes: four which applied 

DeGayner’s method at varying levels of specificity and one which followed the failed 

‘revised’ method previously described. The meshes were generated in the following 

manner. I first arbitrarily segmented out the word 'hello' in all capital letters from the 

center of the original point cloud. No other points were removed. The many obvious, real 

petroglyphs were therefore 'mistaken' for natural rock and left alone. This simple 

segmentation was then used to make a mesh in accordance with the revised method I 

have described, labeled Sample A (Fig. 30a).  

To make the other four meshes, I next used the segmented cloud to expediently 

simulate the manual selection of points per DeGayner’s normal method. I randomly 

subsampled the cloud to 10%, 1%, and 0.1% of the points in the master point cloud to 

create Samples B through D (Figs. 31a, 32a, 33a, respectively). Finally, to best replicate 

Figure 29: a) Combined scalar fields from Figs. 26-28; b) Averaged scalar fields from 
Figs. 26-28. 

a b 
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DeGayner’s method as it would likely be used by a researcher, I manually selected 

3,514 points around the imagined ‘hello’ glyphs (Fig. 34), then joined this cloud to a 

clone of Sample D to achieve coverage of the entire stone (Fig. 35a). I then completed 

the remaining steps to generate a colorized scalar field from each sample. 

 

Table 2. List of Dighton Rock Point Clouds 

Name Description Points % of Master 
Cloud 

Master Cloud Master point cloud 221,739 100.00 % 
Sample A Master cloud minus points comprising the 

word ‘hello’ 216,676 97.72 % 

Sample B Random subsample of Sample A 22,170 10.00 % 
Sample C Random subsample of Sample A 2,217 1.00 % 
Sample D Random subsample of Sample A 222 0.10 % 
Sample E Sample D plus 3,514 points manually 

selected from around the word ‘hello’ 3,736 1.68 % 

 
 

 
In the resulting scalar fields, we see the impact of our selection especially with 

the clouds retaining the most points. In Figure 30b, the only difference to be found 

between Sample A and our Master Cloud came from our point selection, resulting in the 

apparent corroboration of entirely fictitious petroglyphs. The colorizations derived from 

Sample B (Fig. 31b), Sample C (Fig. 32b), and Sample D (Fig. 33b) continue in the 

same pattern, demonstrating the direct relationship between the density of the sample 

and the bias introduced by our sampling. That is, the more points we retain from the 

Master Cloud, the more heavily this sampling strategy will distort our colorization. 
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Figure 30: a) Sample A; b) Resulting scalar field from distance computation between 
Sample A and Master Cloud 

a 

b 
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Figure 31: a) Sample B; b) Resulting scalar field from distance computation between 
Sample B and Master Cloud 

a 

b 
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Figure 32: a) Sample C; b) Resulting scalar field from distance computation between 
Sample C and Master Cloud 

a 

b 
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Figure 33: a) Sample D; b) Resulting scalar field from distance computation between 
Sample D and Master Cloud 

a 

b 



47 

  

Figure 34: Points added to Sample 
D to form Sample E 

Figure 35: a) Sample E; b) Resulting scalar field from distance computation between 
Sample E and Master Cloud 

a 

b 
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At first glance, the results of Sample E (Fig. 35b) would therefore appear 

anomalous. The word ‘hello’ is even more visible than in the colorization derived from 

Sample B despite a smaller point cloud (1.68% as opposed to 10.00% of the Master 

Cloud). Upon further inspection, however, this may be explained by the difference in 

sample distribution at the microscale. Whereas Samples B through D were randomly 

subsampled and therefore relatively uniform in point density, in Sample E we gathered a 

majority of our points from the area of interest where we believe the glyphs to occur. The 

result, illustrated in Figure 36, is that a small area around ‘hello’ where the distortion is 

strongest retained 3,521 out of 15,826 points, or 22.25% of the Master Cloud. 

 

The surrounding area, in contrast, comprised 215 out of a possible 205,913 

points, or 0.10% of the Master Cloud. This is why the colorization outside of the small 

area around ‘hello’ is virtually identical to the results of Sample D. This is significant 

particularly because it is how a researcher is likely to actually sample the cloud, taking 

Figure 36: Sample E analysis. The sampled points [neon green] inside the inner 
rectangle [orange; 15,826 points] comprise 22.25% of the Master Cloud, 
whereas outside of this area [teal; 205,913 points] the remaining sampled 
points [215] amount to only 0.10% of the Master Cloud. 
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the most time to select points around areas they believe contain petroglyphs. I am 

compelled therefore to reject a colorization method based around manual point 

selection, since our findings are not only biased by the subjectivity of the process but by 

the natural tendency to select an irregular distribution of points. That the bias errs 

towards confirmation of the researcher’s preconceptions and does so in a way that is 

difficult to detect heightens the danger it poses. 

I adopted an open-minded approach to brainstorming objective alternatives, 

operating on the premise that uniform manipulations and sampling strategies offer fewer 

opportunities for the introduction of distortion and bias to the colorizations. While later 

continuing to experiment with downsampled clones of the Master Cloud as a route to 

visualizing petroglyphs, this brainstorming also led me to novel approaches. I began by 

experimenting with more basic methods, computing distance against a flat plane. This 

enabled the creation of colorizations without any alteration or manipulation of the master 

cloud but came at the expense of eliminating global curvature as a source of distortion. 

The conceptual basis for measuring against a flat plane is illustrated in Figure 37. In 

contrast to colorizations derived from a clone of the master cloud, as in Figure 38, we 

can see the failure to account for global curvature in the final product. This approach can 

nonetheless prove useful, is achievable by several different methods, and may be 

integrated into several different workflows. 

One of the better methods for colorizing planar distance is also perhaps the 

simplest. With a mesh or cloud selected, the user navigates to the toolbar and selects 

Tools>Fit>Plane. CloudCompare then automatically applies a least-squares fitting 

algorithm to determine a plane of best fit for the cloud or mesh. Then we simultaneously 

select the master cloud and the plane before computing primitive distance (Fig. 41), 
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which will create a scalar field. Figure 42 shows the results of this process applied to 

Loubser and Logan’s (2017) scan of Judaculla Rock, with and without a corresponding 

texture. Though the stone is relatively flat, the dips and high points of the rock dominate 

the colorization. Other apparently ‘flat’ scans fare no better: In a colorization of Dighton 

Rock (Fig. 39) generated by the same operation, the global curvature of the rock again 

obfuscates glyph details so that they cannot be viewed simultaneously, regardless of 

changes to scalar field display parameters. The distortion is predictably greater on 

stones with greater curvature, as shown in a colorization of the Octoraro Creek 

petroglyphs (Fig. 40). Despite the shortcomings of this method, it does enable us to 

reveal some otherwise invisible glyph details by way of manipulations to the scalar field 

display parameters, especially on relatively flat stones. 

Figure 37: Cutaway section drawing illustrating the premise of the colorization 
process with a flat plane. 
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a. 

b. 

c. 

d. 

e. 

f. 

Figure 38: Cutaway section drawing illustrating the premise of DeGayner’s 
colorization process. a) 3D scan of rockface with petroglyphs and natural 
geological features, annotated; b) Point selection of unaltered rock; c) Sample 
of selected points (b) exported as a new point cloud; d) Low-resolution mesh 
reconstructed from new point cloud (c) approximating the original petroglyph-
free stone – note the absence of incising; e) Distance computation between 
original point cloud (a) and reconstructed mesh (d); f) Colorized scalar field 
produced by distance computation, applied to the original point cloud or 
mesh. 
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Figure 39: Dighton Rock distance computed to a fit plane. 

Figure 40: Octoraro Creek Petroglyph distance computed to a fit plane. Note the 
absence of identifiable petroglyphs. 
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Figure 41: Judaculla Rock, measuring primitive distance to a fit plane. 

Figure 42: Judaculla Rock distance computed to a fit plane. (left) without texture; 
(right) with texture. 
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While measurement against a flat plane therefore improved the objectivity of the 

process, pursuing an idealized schematic view would clearly require a method which 

eliminates global curvature. During the course of this research I learned of a relatively 

new tool aimed at solving our exact problem. TVT, or Topography Visualisation Toolbox, 

formerly known as Ratopoviz (Rock Art Topographic Visualization), is a software 

developed at the University of Gothenburg, Department of Historical Studies and Centre 

for Digital Humanities, which is designed to enhance the visibility of petroglyphs in 3D 

scans. TVT essentially debuted with Horn, Pitman, and Potter (2019), who outline a 

process in which they apply the toolkit of landscape archaeology, converting 3D 

petroglyph data to DEMs that may then be used to improve visualization of fine details. 

Horn et al. (2022) refined this concept and created a program to automate the 

process. This program was made freely available to researchers as Ratopoviz but has 

since been renamed the Topography Visualisation Toolbox. TVT version 2.1, the latest 

version available at the time of writing, was used for the work presented here. TVT is 

comprised of two tools: a “Topographic Visualisation” tool and a “Digital Frottage” tool. 

Topographic Visualisation converts 3D scans into 2D raster images; in this form, it 

outputs depth maps, topographic maps, and normal maps among various blended 

versions of the same. This tool therefore produces images that are largely similar to our 

distance computations against a flat plane. 

Topographic Visualisation also provides point cloud data (.pcd) files which may 

be used in the Digital Frottage tool. The Digital Frottage tool produces something more 

aligned with our goals as it attempts to enhance glyph details rather than merely 

visualize topography. The manner in which the program enhances the visibility of 

petroglyphs is essentially thus: 3D data is projected onto a two-dimensional plane, the 

image is "defocused" through Gaussian blurring, and then the pixel values of this 

defocused image are subtracted from the original, thereby effectively eliminating the 



55 

global curvature from the image and retaining only the fine details (Horn, Pitman, and 

Potter 2019:4-5; Horn et al. 2022:193-196). I applied TVT to several of the scans in our 

dataset and received mixed results. 

Predictably, the depth and topographic maps generated by the Topographic 

Visualisation tool were generally dominated by the global curvature of the stone. Some 

of these results made the petroglyphs clearer than when measured against a flat plane, 

however. Moreover, the texture maps and normal maps gave useful visualizations even 

if they do not enhance faint markings at all. Some of the images generated had such 

poor contrast that they were rendered useless. While generally on par or surpassing 

simple measurement against a flat plane in CloudCompare, the images created by this 

tool lack the customizability of scalar field display parameters, while lacking the clarity 

and scalable image resolution also possible with scalar fields. 

Applying the Digital Frottage tool presents its own problems. Though the program 

includes a basic user manual, it is still not entirely clear how certain parameters set by 

the user impact the program’s operation. Additionally, the manual does not clearly 

enumerate how the multiple files that are produced correspond to the operations 

conducted by the tool. By systematic, iterative changes to the input parameters I found 

combinations that produced usable visualizations of the petroglyphs in our dataset, but 

many other combinations did not. Ultimately, I found that increasing the “Neighbourhood 

Size” parameter in the “Noise Reduction Settings” was necessary in order to make the 

petroglyphs clearly visible. With otherwise default parameters, I processed most of my 

dataset using the .pcd files previously generated by the Topographic Visualisation tool. 

This successfully eliminated most of the curvature from the visualizations (Figs. 43-47). 

Nonetheless, the images comprising Figures 43-47 generally needed adjustments to 

brightness and contrast in order to view the petroglyphs.  
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Figure 44: Pimmit Run 
Petroglyph 
colorization 
produced by TVT 
(rotated differently 
from previous 
depictions). 

Figure 43: Judaculla Rock 
colorization 
produced by TVT. 
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Figure 45: CHOH-26 colorization produced by TVT. 

Figure 46: Octoraro Creek Petroglyphs colorization produced by TVT (rotated 
differently from previous depictions). 
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Like its sister tool, Digital Frottage suffers from several drawbacks. The Digital 

Frottage tool required an excessive amount of time to complete its operation on CHOH-

26, likely due to the comparatively large size of the file. Topographic Visualisation 

outputs an ‘original.pcd’ and a ‘transformed.pcd,’ and of these two the latter was 

preferable as our input for Digital Frottage. The original.pcd file sometimes is not 

properly oriented for use, so the tool processes the point cloud on the wrong axis. 

Transformed.pcd is a transformation of the point cloud which will ensure proper 

orientation in Digital Frottage; however, this may still produce an incorrect or undesired 

rotation of the final image. This can especially pose a problem because image rotation is 

generally a ‘lossy’ transformation (i.e., one that reduces image quality), although this 

depends on method and degree of rotation. 

Digital Frottage outputs both .tiff and .png images, and while the .tiff images are 

of a higher quality, they are more difficult to work with and can display differently 

depending on what program is used to view them. As previously mentioned, the tool is 

somewhat difficult to control with regard to finding ideal parameters. Repeated operation 

Figure 47: Dighton Rock colorization produced by TVT. 
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of the tool is needed to see how different input parameters change the visualization, 

inhibiting timely feedback to the user. Repetition is also required to change the 

symbology to different color ramps. For example, to view an otherwise identical image 

on a blue-green-red spectrum rather than a simple black-white gradient requires two 

operations of the tool. Contrast this with the instantaneous feedback provided by 

changing scalar field display parameters in CloudCompare, as well as the ease of 

switching between the many different color ramp options. Moreover, CloudCompare 

allows the creation of custom color ramps. 

These issues also relate to problems common to both tools in TVT. While the 

toolbox automates complex processes and thereby saves users a great deal of effort, 

these tools still take time to run. The trial-and-error required to find ideal input 

parameters and the necessary repetitions to get desired visualizations compound with 

the time the tools take to operate. Lacking a pre-made .pcd or DEM file, applying 

Topographic Visualisation to a petroglyph scan represents the most sensible workflow 

for obtaining a .pcd file compatible with Digital Frottage. The time to operate 

Topographic Visualisation can therefore be included in the time it takes to run Digital 

Frottage. TVT additionally works entirely on the computer’s central processing unit 

(CPU), and the authors warn about the toolset’s high memory usage. This processor-

intensive operation can make the performance of other tasks at the same workstation 

impracticable while either tool is running. 

Yet, the biggest issue I identify is one of image resolution and scalability. The 

quality even of the higher resolution .tiff images produced by TVT cannot compare to the 

image resolution possible when working directly with a scan in software such as 

CloudCompare. With a scalar field, for example, color is assigned to each of potentially 

millions of points. Many images may therefore be taken at many different scales without 

loss of detail. In contrast, TVT offers only images of the entire scan. To see a small 
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detail on Judaculla Rock, for example, one could crop an image output by TVT but this 

image will be visibly pixelated (Fig. 48). One would need to crop the 3D scan itself and 

repeat the use of TVT in order to see the same area in the greatest possible resolution. 

In contrast, Figure 49 shows the same area, with a comparable black-white color ramp 

achieved in CloudCompare. The file size of the latter is 2,323 times that of the cropped 

TVT image and contains almost 465 times the number of pixels. Moreover, this is but 

one of countless options for rendering the CloudCompare display. CloudCompare allows 

one to customize the output for a larger or smaller image, giving complete control over 

final resolution and scale. 

The aforementioned problems are in large part a circumstantial product of our 

differing goals. Horn, Pittman, and Potter (2019:4-5) identify the large file sizes of 3D 

models as a barrier to the dissemination of petroglyph research and therefore view the 

significantly reduced file sizes of TVT’s products as a virtue. Objective depictions of 

petroglyphs can be made and then easily hosted online, reproduced in print, and 

accessed without regard for computing power. Likewise, the limitations to user control 

over visualizations are a cost of simplicity and ease of use, for 3D modeling softwares 

can require “technical skill which potentially restricts their non-specialist use” (6). 

Contrary to the goals of Horn’s team, this work is rather focused on developing the 

means to analyze 3D petroglyph data and sharing these methods with researchers so 

that they too can analyze petroglyph data as specialists. These methods do not preclude 

researchers from presenting their work via 2D imagery but rather expand the options for 

customizing presentation. I emphasize, however, the need for a process which applies 

colorization to three-dimensional space on an unaltered model, exhausting the 

capabilities of 3D data while remaining accessible to the average archaeologist. While it 

is clear that TVT is not a substitute for the work pursued here, it does offer us a 

conceptual basis for moving forward: using blurring or smoothing and subsequent 
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Figure 48: Crop of Fig. 43, created using TVT, zooming in on a specific glyph on 
Judaculla Rock. This image is in .png format; 42.7kb; 293x191 pixels. 

Figure 49: Visualization of Judaculla Rock in CloudCompare, zoomed to the same 
area presented in Fig. 48. This image is in .bmp format; 99,200kb (or 
99.2mb); 6313x4121 pixels. 
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subtraction of a defocused simulacrum as a means of eliminating global curvature. 

There are multiple ways in which I suggest we might apply this concept. 

The first method employed is conceptually identical to that pioneered by Trinks et 

al. (2005). This same concept has been reinvigorated by Zeppelzauer and Seidl (2015) 

and adapted by Horn et al. (2022). The approach I describe thus follows closely the 

procedure performed by TVT, but it is done entirely within the CloudCompare software. It 

therefore differs from these works in keeping the colorization process within 3D space: it 

does not involve 2D image projection and the final product is a colorized 3D model. We 

return to a distance computation against a flat plane but with the addition of procedures 

to eliminate curvature. The steps are as follows: 

1) Fit a plane to the mesh or cloud. [With the Master Cloud or mesh selected, 
Tools>Fit>Plane] 

2) Compute distance between the plane and Master Cloud. [With both the plane 
and point cloud selected, Tools>Distances>Cloud/Primitive Dist] 

3) Apply a Gaussian filter to the created scalar field; the default sigma value 
offered by CloudCompare generally works well. [With the Master Cloud or 
mesh selected, Edit>Scalar Fields>Gaussian Filter>(selected sigma value)] 

4) Subtract the blurred scalar field from the original scalar field [Edit>Scalar 
Fields>Arithmetic>(SF1 minus SF2)] 

The scalar field produced by this process works very well at revealing small details in the 

mesh and, unlike measurement against a flat plane alone, succeeds at making them 

simultaneously visible. This is because the distance measurements against the plane 

may be characterized as the total curvature of the stone, including both minor and global 

variation in the surface. A Gaussian filter applied to the scalar field containing these 

distance values eliminates minute curvature and approximates the global curvature. 

Subtracting the Gauss-filtered (global) from the unfiltered (total) leaves us only with the 

minute curvature of the surface. Another way of framing this is to say that the final scalar 

field only manifests the small surface details obfuscated by Gaussian blurring. 

One benefit of this approach is that, by doing the bulk of these calculations on 

pixel values, we save time by avoiding taxing computer operations like cloning,  
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then scalar field was subjected to Gaussian blurring at 0.02925856 sigma. This 
scalar field was then subtracted from the original, unblurred scalar field. 

Figure 50: Judaculla Rock colorized by 
distance computation to flat plane with 
Gaussian blurred scalar field arithmetic. 
Distance to a fit plane was computed, 



64 

manipulating, and reconstructing the original 3D scan. There are also problems with this 

approach, however. As previously outlined, CloudCompare utilizes a least-squares fitting 

algorithm to pair a best-fit plane to the cloud or mesh. Anywhere that the mesh is 

perpendicular to the fit plane, the distance measurements will not properly capture 

surface variation. This can be seen on Judaculla Rock, for example, where the 

colorization of the sides is little more than meaningless noise. Thus, this method is not 

capable of illuminating the entirety of any mesh with right angles. In the same vein, 

performance drops off with increasingly oblique angles as the mesh moves away from 

parallel to the fit plane. A laborious but serviceable workaround is to segment out such 

areas, individually fitting a plane to them and repeating the process. 

  

Figure 51: Detail of one side of Judaculla Rock, showing an anthropomorph. On the 
left (a), the colorization derived from a fit plane devolves as the mesh curves 
perpendicular to the plane. On the right (b), a different colorization method 
shows the obscured details. 
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Figure 52: Another side of Judaculla Rock. On top (a), the colorization derived from a 
fit plane is distorted by meaningless noise. This is due to the perpendicularity 
of this side of Judaculla Rock to the fit plane. Below (b), a different 
colorization method shows the obscured details, including cupules and lines. 
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Another simple manner of achieving a colorization is outlined by Mark (2017). 

Mark exports a dense point cloud from a 3D model and opens it in CloudCompare, 

applies the E.D.L. shader, and finally applies the PoissonRecon plugin to the point cloud 

to generate a new mesh. Recognizing that “a generalized surface is fitted to the points” 

by PoissonRecon, Mark suggests that the “display of the points below the surface” is 

creating the visualization. Mark’s instructions demonstrate some confusion as to the 

reasons for the successful colorization and also include unnecessary steps. His 

instructions additionally omit key details. Shading is largely immaterial to this operation. 

Much more important are the normals enabling shading. The cloud must have computed 

normals in order to use Poisson reconstruction, which generates a new mesh. It is the 

imperfect fit of the Poisson reconstructed mesh to the original point cloud that makes 

details visible, as the reconstructed mesh ‘bleeds through’ in areas with incising or 

natural depressions. The key requirements of Mark’s ‘digital rubbing’ process then are a 

cloud with normals to use with the PoissonRecon tool, a different color assigned to the 

mesh and the original point cloud, and their simultaneous display. 

By eliminating the unnecessary shader, turning off normals (which eliminates any 

shading at all), and using the original mesh for a backdrop rather than a dense point 

cloud, we get something more akin to a genuine rubbing (Fig. 53b) than if we follow 

Mark’s procedures exactly (Fig. 53a). Though arguably producing a noisier visualization, 

fewer details are obscured. The benefits of these changes are more apparent with a 

lower resolution mesh, such as Dighton Rock (Fig. 54). Mark’s method still produces a 

less than ideal visualization partly because of the aforementioned problems with using 

Poisson reconstruction for the simulacrum. I therefore reinvent this process through the 

use of a smoothed clone placed below the original mesh. Like with Mark’s process, the 

lower resolution clone will bleed through in the areas of smoothing that become raised 
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Figure 53: a) CHOH-26 “digital rubbing” following Mark’s method; b) CHOH-26 “digital 
rubbing” with revised method. 

a 

b 
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Figure 54 (above): a) Dighton Rock 
“digital rubbing” following 
Mark’s method; b) Dighton 
Rock “digital rubbing” with 
revised method. 

 
Figure 55 (right): Cutaway section 

drawing illustrating the 
premise of placing a 
smoothed mesh beneath 
the original 

a 

b 
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above the original mesh. Figure 55 illustrates the concept with sine waves representing 

the original and smoothed meshes. The original mesh (in black) sits atop the smoothed 

mesh (in blue). From a top-down view, the less amplified curvature of the smoothed 

clone peeks through only at low points of the original mesh. 

Applying Laplacian smoothing to a clone of CHOH-26 produces a viable if heavy-

handed colorization of the site’s petroglyphs. This method unfortunately includes 

significant noise from the natural irregularities in the rock’s surface. This approach also 

requires that one set unique color values for each mesh in order to create a visual 

contrast, which is primarily a disadvantage where the original rock texture is attached to 

the scan via the RGB color channel. Figures 56-59 show the application of this method. 

The images also show that with a progressive increase in smoothing, more of the 

cloned mesh comes through and lines both natural and anthropogenic become more 

distinct, albeit with a commensurate loss of fine detail. Figures 56-57 show the original 

mesh in black and the smoothed mesh in white, while Figures 58-59 show the colors 

reversed. The cloned meshes in Figures 57-58 have been equally smoothed; Figure 56 

shows the least smoothing and Figure 59 evinces the greatest smoothing. This 

approach appears useful for quick, binary segmentations but is limited both in 

customizability of the visualization (compared to a scalar field) and in the obtainable 

clarity of visualization. 

The third method I attempted simply takes the previous method a step further. 

We compute distance between the Master Cloud and a downsampled or smoothed 

clone to imprint the difference on a scalar field. The methods used here build upon my 

findings in experimenting with DeGayner’s method. After additional trial and error, I 

homed in on a couple procedures for generating the simulacrum mesh which seemed to 
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Figure 56: CHOH-26 smoothed once, color set to white, against backdrop of the 
original, color set to black. 

Figure 57: CHOH-26 smoothed three times, color set to white, against backdrop of 
the original, color set to black. 
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Figure 58: CHOH-26 smoothed three times, color set to black, against backdrop of 
the original, color set to white [i.e., Fig. 57 with color inverted]. 

Figure 59: CHOH-26 smoothed six times, color set to black, against backdrop of the 
original, color set to white. 
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work best under certain conditions. The first route is characterized by subsampling the 

point cloud to create a new, downsampled mesh, while the second option is to clone and 

smooth the original mesh. With either approach there is still considerable room for 

variation. 

Subsampling of the Master Cloud may be accomplished via space, octree, or 

randomly. That is, the user can set minimum space between points, octree subdivision 

level, or specify the number of points to randomly sample. The principle by which 

visualization is achieved is the same: distance measurement between the original scan 

and a simulacrum of the unaltered stone. Yet, rather than using Gaussian blurring or 

Laplacian smoothing alone to form the simulacrum, ‘smoothing’ is achieved by feeding 

fewer points to the mesh-creation process. This gives us a simulacrum that retains 

global curvature but lacks fine surface detail. The problem with this is that ‘smoothing’ by 

this method is anything but smooth, and each of the three sampling strategies produced 

equally poor results by themselves. I therefore found it necessary to apply Laplacian 

smoothing to the subsampled mesh before computing distance, otherwise the 

jaggedness of the recreated mesh leads to an arbitrarily mottled visualization. I found it 

expedient and effective to subsample between one and ten percent of the original mesh. 

Our second option is to simply clone the mesh and use Laplacian smoothing 

exclusively to generate the simulacrum. While the input parameters for Laplacian 

smoothing can be freely adjusted, numerous trials with several scans from our dataset 

suggested that between twenty and forty iterations conducted at a smoothing factor of 

0.2 worked well for visualizing glyph details (Fig. 62). In all trials to this point, the 

colorizations created by simply cloning and smoothing the original mesh evinced 

improved detail compared to colorizations derived from a subsampling approach. 

Moreover, the Delaunay-generated mesh tends to imperfectly recreate anything but very  
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Figure 62: Colorization of Judaculla Rock generated by distance computation to a 
smoothed clone. The cloned mesh was smoothed 20 iterations at 0.2 smoothing 
factor. 
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flat scans. Similar to methods employing a fit plane, this results in completely inaccurate 

and mottled colorizations around curves and the sides of rocks. 

The three most promising methods outlined thus far then are distance to a fit 

plane with scalar field arithmetic, distance to a subsampled reconstruction, and distance 

to a smoothed clone. Yet, in comparing the three, the latter approach initially appeared 

superior. The former two routes offered only a couple of minor advantages. The first is 

that they are faster operations; however, the time savings were minimal since none of 

the operations required more than around twenty minutes to complete. The second 

advantage may be more aptly described as a disadvantage viewed in a positive light. 

The diminished detail of the first two approaches results in bolder and less ambiguous 

lines – at the expense of missing the most faint or eroded carvings. However, this same 

effect may be achieved by applying Gaussian blurring to the highly detailed visualization 

derived from a smoothed clone. Thus, there is little argument for preference on this 

account. The failure of the first two methods, however, to truly depict surface details in 

all three dimensions offers a glaring disadvantage. 

On the verge of accepting the primacy of using a smoothed clone for all 

colorizations, I conducted work on CHOH-3. This scan possessed a much greater 

number of points than any of the other scans heretofore experimented upon. The mesh 

for CHOH-3 was cloned and smoothed twenty iterations at a smoothing factor of 0.2 

(Fig. 63). Surprisingly, I found the results incongruent with my results using the same 

process on other scans. The final visualization did not remotely enhance the visual 

contrast of known carvings on the stone, whereas a colorization using a one percent 

subsample of the point cloud returned an extremely effective visualization. From 

personal observation of the stone and documentary evidence, I knew that CHOH-3 is 

approximately the same size or smaller than other sites in our dataset. Yet, the collected 

point data for CHOH-3 outnumbers our next largest point cloud by a factor of nine. This 
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led me to hypothesize that point cloud density played a key role in the failure of what had 

been so far an ideal method. I had throughout this work increasingly suspected that the 

number of points collected relative to the real-world area covered by the scan posed an 

unavoidable problem as an uncontrolled variable needing to be addressed. 

I therefore first resolved to attempt a task that had previously appeared fraught 

with uncertainty: determining the relationship between a real-world unit of measurement 

and the distances returned in 3D modelling software. To this end, I gathered what 

documentation existed that could indicate the size of the petroglyph stones and 

individual carvings. This information could then be cross-referenced with distance 

measurements taken in CloudCompare to deduce the unit of measurement used by the 

3D model. The unit used in some scans could be said with greater certainty. 

CHOH-3, CHOH-26, and the Pimmit Run boulder were well documented by 

Doering and Collins (2013), and I found these scans consistently used millimeters as 

their standard unit. Despite its long history, Dighton Rock lacked well documented 

measurements. I therefore relied on the NRHP nomination form (Hale 1971), rough 

descriptions and photographs of individuals next to the stone for scale. Fortuitously, the 

extremely small unit of measurement helped eliminate other possibilities and I 

determined with relative certainty that the scan used tenths of a millimeter. Judaculla 

Rock proved likewise difficult to find measurements for, but a detailed diagram with 

thirty-centimeter scale produced by Loubser, Ashcraft, and Wettstaed (2018:209) led me 

to conclude that the high-resolution scan reports distance in half meters. 

With this information I was able to calculate the points per square meter of real-

world surface area (i.e., point density) in each scan. The results are shown in Table 3. 

Though there is still some uncertainty to these conversions without further corroboration 

through fieldwork or additional documentation, they approximate the point densities 

sufficiently well. 
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These calculations comprise the beginning steps in a final process I developed 

for colorizing petroglyph detail, offered in Appendix B. Possessing information about 

point density equipped me to adapt my previously outlined methods so that they could 

work with very detailed scans like CHOH-3. More importantly, control of this variable 

aided me in systematizing the colorization process so that it may flexibly work with the 

many different contexts in which it may be applied. 

I selected the attributes of Loubser and Logan’s (2017) Judaculla Rock scan as a 

baseline for devising this process since the smoothing-based colorization performed 

excellently at revealing small glyph details. This scan had a point density of 44,209.55 

p/m2, and the clone used in the colorization was smoothed twenty iterations at a 

smoothing factor of 0.2. This formed the basis for two formulas, each for a different 

method of achieving a colorization: Formula A would govern distance computations to a 

smoothed mesh clone, while Formula B would govern distance computations to a 

subsampled, reconstructed mesh. I chose to set 45,000 p/m2 as a benchmark for 

smoothing a clone twenty iterations at 0.2 smoothing and assumed a direct linear 

relationship between the appropriate number of iterations and point density. Likewise, 

45,000 p/m2 was used in Formula B as an ideal point density to subsample a cloud down 

to for reconstruction. 

With these formulas, both methods were able to effectively colorize the glyphs on 

CHOH-3 (Figs. 64-65). The application of these formulas also delivered positive results 

with other high-density scans by Doering and Collins (2013). Trials with different 

benchmarks moreover did not produce better visualizations, and the formulas were 

therefore not altered. After confirming the usefulness of this revised system on various 

scans in the dataset, I sought to test this method on a few new, unfamiliar scans. 
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Figure 63: CHOH-3 smoothed 20 iterations at 0.2 smoothing factor. 
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Figure 64: CHOH-3 smoothed 2000 iterations at 0.2 smoothing factor. 
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Figure 65: CHOH-3 subsampled to 45,000 points per square meter and smoothed 20 
iterations at 0.2 smoothing factor. 
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I first downloaded a 3D model of a petroglyph stone found on the Kennebec 

River near Embden, Maine from the Sketchfab website. This scan was apparently 

recorded as well as uploaded by a member of the New England Antiquities Research 

Association. Like with the Dighton Rock scan, this data was therefore subjected to 

greater scrutiny. However, the scan appears to be the unaltered product of now 

commonplace consumer-grade scanning software, and the authenticity of the glyphs 

themselves is well-established. Having judged this 3D model to be unadulterated, I 

followed the process outlined in Appendix B. The scan came in .glb file format, which 

CloudCompare cannot read. I therefore used Aspose.3D, an application programming 

interface for the Python programming language, to run code that would convert the 

petroglyph scan into a .ply format. I was then able to open the file in CloudCompare. 

I compared distance measurements on the scan to measurements on sketches 

made by E.W. Moore in 1894 and in a photo by Lenik (2002:57) to deduce the unit of 

measurement. After converting the surface area of the scan output by CloudCompare 

into square meters, I was able to calculate point density to use in Formula A. 

Determining that 237 iterations were needed at a smoothing factor of 0.2, I then 

generated a colorization by distance computation to a smoothed clone. Likewise, I used 

Formula B to determine the number of points to retain in a random subsample, and from 

here I followed the process for generating a colorization from a subsampled cloud. 

These colorizations are shown in Figures 66-67. 

Crack-like fissures (Fig. 68) appear throughout the visualization created by 

smoothing the mesh; this is likely caused by scanning with an iPhone, as available 

applications typically stitch together smaller scanned areas to create a larger model. 

This was remedied in Figure 67 by reconstructing the mesh from the original cloud as 

we would with a subsampled cloud. However, on some scans this will result in loss of 

visualization accuracy around the sides of a stone. 
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Figure 69 (left): a) Detail of 
several petroglyphs after 
colorization, next to (b) a sketch 
of them made by E.W. Moore in 
1894. 

Figure 68 (above): 
Detail view of the 
fissure-like distortion in 
the scalar field 
generated via a 
smoothed clone. This is 
the result of the 
piecemeal recording 
method used by 3D 
recording software on 
equipment like smart 
phones. 

b 

a 



87 

The next scan covered petroglyphs from much further away: the island of St. 

John in the United States Virgin Islands. Besides the availability of the scan, these were 

chosen because the Reef Bay petroglyphs have been documented by researchers and 

posed an opportunity for comparison and corroboration of our colorization. Diagrams by 

Dubelaar (1991) allowed for easy conversion of surface area measurements. As with the 

Embden petroglyphs, I used the two revised methods, employed the appropriate formula 

for each, and generated two colorizations. The colorizations agree with the petroglyphs 

recognized in Dubelaar’s diagrams and by the general public, corroborating their validity. 

However, they also reveal new petroglyphs which are so faint that they previously 

eluded notice. Note, for example, the hints of overlapping clusters of faces (Fig. 74) 

which are now too worn to be seen by the naked eye. Other unrecorded petroglyph 

details are plainly visible, such as a repetition of an existing eye motif and many cupules 

(Fig. 75). 

  

Figure 70: Photograph 
by Scofield and Allmon 
(1956:220) of watercolor 
paint applied to 
petroglyphs at Reef Bay 
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Figure 71: 
Diagrams of 
Reef Bay 
petroglyphs by 
Dubelaar 
(1991:958). 
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Figure 74: Detail of faint but perceptible glyphs with indicator arrows; these appear to 
be overlapping circles with cupules and are perhaps meant to depict faces. 

Figure 75: Detail of unrecorded glyphs with indicator arrows; these include groups of 
cupules, the repetition of an ‘enclosed eye’ motif, and an apparent face. 
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I lastly return to a scan in our original dataset and compare my colorizations of 

Dighton Rock to its depictions through time. Figures 77-78 show Dighton Rock colorized 

according to my method. Perhaps the most significant conclusion that can be made from 

the analysis of Dighton Rock concerns how utterly suspect many pre-twentieth-century 

depictions of complex petroglyphs now appear. In Figure 76 we see some of the earliest 

of the now innumerable interpretations of Dighton Rock. While there is generally some 

commonality between the drawings, they all seriously deviate from the reality of the 

carvings which they are meant to depict. This is not to mention the additional mistakes 

introduced by repeated, imperfect copying. Mallery, from whom these specific diagrams 

were sourced, does not accurately reproduce either of the earliest sources for John 

Danforth’s sketch, which are copies made by Isaac Greenwood in 1730 (Delabarre 

1917). Further still, the great discrepancy between Greenwood’s two handmade copies 

leaves us to ponder the actual appearance of Danforth’s original. This gives us cause to 

reevaluate sources whose authority was previously accepted. 

Over the course of more than 340 years, perhaps only one of the many sketches 

and reproductions of Dighton Rock has discerned the second, stylistically similar 

zoomorph hidden in the palimpsest immediately to the right of its companion. Ironically, it 

was Edmund Delabarre who recognized the markings and depicted them in a sketch 

alongside his own fanciful inventions, such as the alleged inscription of Miguel Corte-

Real (Delabarre 1919:416). Neither of the zoomorphs as he draws them are entirely 

accurately portrayed and the front half of the figure on the right is his conjecture; he 

assumes it to be a repetition of the ‘deer’ to the left. Nonetheless, the oversight by 

previous observers is all the more striking given the clarity with which the less disfigured 

zoomorph may be perceived, as evinced by numerous accurate representations of the 

animal on the left since at least Stephen Sewell’s 1768 sketch of the stone. Thus, even 

with the exact pattern to be recognized plainly before them, sitting mere inches from its  
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Figure 76: Compilation of depictions of Dighton Rock through time. Reproduced from 
Tufte 1990:72, after Mallery 1893:762-763. 
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counterpart, countless researchers could not detect the motif. There is cause to consider 

that these figures may have been retouched as described by Hunter. Our colorization 

shows lines which may have comprised the zoomorph and which are clearly less distinct 

than others, perhaps indicating partial reengraving of an initial figure. The more 

significant contribution our colorizations have to make lies in what they can disprove. 

Delabarre (1928:172) goes so far as to assert that glyphs outlined in Figure 79b are 

“Indian glyphs overlying and obscuring the Cortereal [sic] inscription” [emphasis added]. 

Yet, Figures 77-78 clearly demonstrate the contrived nature of Delabarre’s 

alleged Portuguese inscription. Even setting aside the likelihood that someone has 

deepened the carvings to agree better with the “signature” of Miguel Corte-Real, we see 

in the visualization no basis for privileging a combination of lines that would make Latin 

script. To interpret the ‘C’ and ‘O’ advocated by Delabarre requires we ignore connected 

lines of equal thickness. Delabarre’s ‘R’ likewise requires that we turn a blind eye to 

inconveniently connecting lines and connect ones that are more nebulous. The entire 

rest of the name is plainly concocted from a few indiscernible marks. The colorizations 

we’ve generated therefore serve to reaffirm the haphazard, confirmatory manner in 

which Delabarre decided on which lines to incorporate into an image. We gain additional 

evidence against his Portuguese hypothesis, which pseudoscientists continue to employ 

in colonial projects of Indigenous erasure. 

I conclude this section by directing the reader to Appendix C, where I include 

photographs of the rest of the main dataset colorized according to the finalized methods 

just demonstrated. These include views of the sides of scans, where applicable. It 

should be kept in mind that though there are generally two images for each scan 

(representing one from each route to colorization), the scalar fields generated by this 

process allow for countless combinations of display parameters. Presenting the range of 



97 

customization options with a scalar field would be better achieved by a video, but 

imagery is naturally more favorable to this medium. 

  

Figure 79: Delabarre’s interpretations of Dighton Rock with demonstrably fictitious 
glyphs; from top to bottom: a)1928:186, fig.35; b)1928:172, fig.28c; c)1919:416, fig.7 
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Figure 80: Dighton Rock colorization in Fig. 78 set to a gray color scale and display 
parameters adjusted. 

Figure 81: Colorization in Fig. 80 filtered by value to isolate the strongest features of 
the engravings. 
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Figure 82: Crop of Fig. 79d, reduced to the area of our scan. 
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Chapter 3: Summary and Discussion 

This last chapter reiterates the research problem, revisits the path that led to my 

finalized process, and summarizes the key lessons learned. A greater portion of this 

chapter is dedicated to situating these results within petroglyph research writ large and 

discusses the implications of my findings. As I stated in Chapter 1, this research has 

sought to fill a pressing need in the archaeology of images on stone by developing an 

objective methodology for improving the visual contrast of petroglyphs in 3D scans. This 

work was designed as a series of iterative trials applying a quasi-experimental pretest-

posttest research technique. Pre- and post-intervention observations were used to 

ascertain whether different manipulations to a 3D model were effective in improving 

petroglyph visibility. Existing tools for petroglyph visualization were also evaluated for 

their efficacy and usefulness. Together these lessons informed the creation of novel 

procedures for petroglyph colorization which were applied to two unfamiliar scans as 

well as the original dataset. The results were again scrutinized in post-intervention 

observations. 

This study began with an exploration of some ‘out-of-the-box’ visualization 

options with software such as MeshLab. These were deemed useful but ultimately 

limited in their capabilities. I next evaluated and attempted to improve upon a method 

used by DeGayner, Rodriguez, and Moss, but in testing discovered the limitations and 

even danger of manual point selection in the formation of a simulacrum. This finding 

necessitated a shift in my approach. I evaluated Horn et al.’s Topography Visualisation 

Toolbox and, while finding it did not fulfill the needs identified by this research, found in it 

a theoretical foundation for our methodology. From this point of departure, I developed 

three routes to colorization but found the uncontrolled variable of point density an 

unavoidable barrier to progress. However, it also proved to be the linchpin in an alternate 

method which could achieve our goals. I revised my process to work with point density 
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as a key factor and developed guidelines to this end. I finally demonstrated the utility of 

this revised process on our original and a secondary dataset. The final products confirm 

that the process performed as expected and substantiate its capacity for visualizing the 

small details of rock markings. 

Ultimately I developed three functioning methods, two of which I judged highly 

effective for making rock markings visible. The less effective but generally satisfactory 

method employed a distance computation against a fit plane, Gaussian filtering of the 

scalar field, and then scalar field arithmetic (Method 1). The two highly effective methods 

employed either a subsampled and smoothed reconstruction of the original mesh 

(Method 2) or a smoothed clone of it (Method 3) in conjunction with information about 

point density. There are some advantages, disadvantages, and constraints to consider, 

both as a whole and between the several methods. 

Method 1 and Method 2 can be completed much faster than Method 3 on larger 

scans. Method 1 is by far the quickest operation. Method 2 outshines Method 3 in speed 

to completion, particularly when a very dense point cloud is being handled. The large 

number of smoothing iterations in Method 3 – 2000 with some of our denser point clouds 

– required anywhere from ten to fifteen minutes; the distance computation between the 

original cloud and the still very detailed clone required at times another thirty. Processing 

speeds for these operations will likely vary significantly depending on the hardware of 

the user, but it is clear that Method 2 demanded fewer resources. On the densest point 

clouds, Method 2 took around one third of the time required by Method 3. Smoothing 

twenty iterations is a quick procedure and the distance computation to the lower 

resolution, reconstructed mesh proves a simpler calculation, also shortening the 

process. Method 1 or Method 2 may therefore be preferable for quick preliminary 

colorizations. Method 1 may be particularly useful in this regard because it is the only 

method of the three which does not require knowledge of surface area or point density to 
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complete. Returning to the matter of expended time, however, it is worth noting that with 

point densities under 1,000,000 p/m2 all methods required less than a few minutes to 

complete. 

Of course, rapidity on those denser scans comes at a cost. The significant 

disadvantage of Method 1 and Method 2 is their failure to accurately visualize the sides 

of rocks. Method 1 is more deficient in this regard: it cannot reveal any details 

perpendicular to the fit plane, and accuracy is diminished the further the mesh strays 

from parallel. Method 2 can in fact show glyph details around edges and sides, but this 

method proves extremely sensitive to slight imperfections in the recreation of the mesh 

and these imperfections are more likely to occur around turns and edges. This causes 

large distances to appear in the distance computation which then obfuscate glyph 

details. This is why a direct clone of the mesh functions so well, as the differences are 

solely the result of our smoothing and there are no confounding variables like imperfect 

mesh reconstruction. With the Embden petroglyphs, I found unforeseen benefits in 

reconstructing the mesh as well. Reconstructing the mesh rather than simply cloning it 

fills the gaps resulting from an MMS stitching together smaller scan areas. It was in fact 

necessary to adapt Method 3 in this way to obtain a suitable colorization. 

I also found in the course of the research that, below a certain point density, 3D 

scans unfortunately do not appear archaeologically useful. Though perhaps self-evident, 

it is worth reiterating that the number of points collected for a given area matters as 

much as the accuracy of each point collected. No process can achieve colorization of 

glyphs on a surface where data about the surface is missing. Below 45,000 p/m2, I 

observed a steep decline in capacity for visualization commensurate with the loss in data 

quality. The lower resolution scan of Judaculla Rock, for example, was excluded from 

further testing when it became clear that the point density was insufficient to show 

petroglyph details. Thus, while scans slightly below the point density threshold I have set 
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might still be capable of generating decent colorizations, no guarantees can be made 

that the methodology will function as intended. With scans at or above 45,000 p/m2, my 

methods are sufficiently sensitive to make full use of the scan resolution, revealing 

petroglyphs that are otherwise imperceptible to the naked eye, both in field conditions 

and even by other visualization methods. 

We should also contemplate the quality of data brought to bear on this topic, for 

only a few scans were survey-grade and professionally recorded. I created this 

methodology intent on making it adaptable to a range of scans yet was still surprised by 

how well it performed with 3D models created and made available by the general public. 

These scans were not intended for this kind of work, and the successful colorizations 

derived from them show what can be done with minimal equipment. The scan of 

Judaculla Rock from which which we generated exceptional colorizations was recorded 

with an iPhone 6 Plus, while newer models of smart phones are continuously adding to 

the technological capabilities of these ubiquitous devices. Our success with avocational 

data speaks also to the possibilities with professional recording using modern TLS, for 

even the professionally recorded scans in this study were made with the equipment 

available a decade ago. 

The question of equipment capability also has relevance as it relates to the 

manner in which petroglyphs were made – or at least how we find them today. In some 

instances, the marks composing petroglyphs are so slight that they even fall below the 

sub-millimeter measurement accuracy of survey-grade TLS equipment. This is more 

common in particularly eroded glyphs or with markings made by abrasion, where a 

strong color contrast between weathering rind or rock varnish and underlying rock 

allowed for an image to be made with little removal of material. Under these conditions, 

this methodology will likely fail to create a discernible visual contrast, and it may be 

better to apply the kinds of image enhancement techniques used for improving the 
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visibility of pictographs. Indeed, any of the scans colorized in this study might also 

contain pictographs or petroglyphs made by contrasting the color of the weathering rind. 

This is one reason that it is extremely useful to have an image of the stone attached to 

the scan as a texture. Terrestrial laser scanning, mobile mapping systems, and 

photogrammetry can nonetheless be useful at such sites due to the possible co-

occurrence of more deeply incised petroglyphs. 

The very nature of the colorization process introduces an unavoidable limitation 

which affects not only my methodology but tools like TVT as well, which operates on a 

similar premise. The manipulations to the model which allow colorization cannot 

differentiate between carvings and small natural features of a similar depth. This is the 

source of significant noise in our visualizations, as the microtopography of the stone is 

as prevalent as the evidence of human agency. In isolating and making visible images 

on stone within a 3D model, there are essentially two steps which must be completed: 

A) Eliminate global curvature from the colorization. 
B) Eliminate the remaining natural features from the colorization. 

Unfortunately, B involves a judgment call which is beyond the capabilities of our process; 

such judgments are consigned to the realm of expert manual segmentation. This is 

perhaps a blessing as well since natural features are sometimes incorporated into the 

creation of imagery. At CHOH-3, for example, the human figure’s eyes are in fact quartz 

inclusions intentionally integrated into the glyph. Ultimately, we must accept that A is 

more realistic than B. In fact, A has been achieved here with my finalized process. In the 

absence of unassailable empirical evidence for human action on an area of stone, B is 

an act of interpretation and should thus always be presented coincident with A. 

I regard the uniform manipulation of the point cloud or mesh as a particular 

strength of my colorization methods since we thereby minimize alterations based upon 

biased preconceptions and concomitant distortions to the finished product. The 



105 

difference may be seen in the juxtaposition between images in Appendix C and some of 

my failed revisions to DeGayner’s method. We thereby improve the overall objectivity of 

the process. Yet, while one of the primary goals of this research has been to explore 

methods for the objective visual enhancement and isolation of rock markings, it may be 

necessary to accept that this task will always be, to some extent, an act of interpretation. 

In the sense that it strives toward unassailable objectivity, this work may even be 

doomed from the start. The technology at our disposal does not allow us to state 

definitively in all cases, based upon empirical evidence, that a given area of rock has or 

has not been altered by human labor. Thus, the work of enhancing glyph visibility begins 

subjectively with the researcher’s recognition of a pattern indicating human action and 

ends subjectively when the researcher feels that their methods are no longer revealing 

additional markings (i.e., the researcher recognizes no additional patterns beyond what 

they deem natural, coincidental, or arbitrary). Even where technology can allow us to 

definitively identify human-made alterations to the rock, the scans on which this process 

relies have been made in the last decade at the earliest. They depict the rocks not as 

they were, but as they are: palimpsest canvases with several hundred years of colonial 

occupation and natural erosion adding to what may have already been a crowded 

ledger, the record of thousands of years spent in communion with Indigenous 

communities. 

Even if one erases from the model those obvious examples of recent 

defacement, the ancient markings are altered by those who have come before to poke 

and prod these Native places, grinding with chalk and charcoal, tracing with fingers and 

walking sticks as they try to discern meaning in signs which were never intended for 

them. Hunter (2017:200) argues that the markings at Dighton Rock are “so interfered 

with and mutilated” that they are now “likely beyond the point of affording any useful 

lesson on antiquity or ethnography.” As Hunter further notes, Dighton Rock has seen 
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constant abuse: it has been carved with graffiti; said graffiti has been chiseled away; the 

markings have been “chalked, painted, scrubbed, and more than likely clarified or 

improved with steel tools by people who wanted to see an inscription that was anything 

other than Indigenous” (200). While this author disagrees as to whether Dighton Rock 

has any lessons left to offer about the Indigenous past, it might first help us learn a 

different lesson by dispelling the ‘Pompeii Premise’ (sensu Schiffer 1985) permeating 

rock marking research. Even as we bring to light faint details ravaged by time, we must 

be mindful of the processes and temporal scale we contend with. 

It seems that one of the greatest challenges to the objective recording and 

presentation of rock-borne imagery is the contradiction between what archaeologists 

desire and what is empirically possible. Archaeologists – this one included – seek 

legible, unambiguous diagrams of petroglyphs as they appeared on the day of their 

creation. Some are even more unrealistic in hoping to reconstruct glyphs exactly as their 

creators intended them. It is often overlooked that some markings may have always 

been indistinct, nebulously blending into the natural striations of the rock, and this may 

well have been the intention the creator. What these archaeologists wish to produce is at 

odds with the reality of many petroglyph sites as we find them today, which bear no 

shortage of hopelessly ambiguous lines. I conclude therefore that presenting these sites 

in their uncertainty, with their collateral ‘noise,’ is an important step in developing an 

objective research methodology for this area of study. While simplified line drawings, 

digital removal of graffiti, and other methods of enhancing and distilling the content of 

images on stone certainly remain useful, we must recognize them for what they are: acts 

of interpretation with underlying assumptions and judgements about things which are 

less than certain. Three-dimensional imaging enables us to see details invisible to the 

naked eye and represent these details in a myriad of ways; yet, despite this 
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technological advancement, the conclusions we draw and patterns we deduce are 

ultimately not so different from the simple, fallible chalking of generations before us. 

While these visualizations did not ultimately produce the clean outlines which we 

may have hoped for, they will in their cautious presentation hopefully stand the test of 

time better than some of the depictions of other petroglyphs I have reviewed. Many of 

the confidently bold, clear diagrams we now rely on for destroyed petroglyph sites were 

not so clear as the authors would have us believe, as evinced by the myriad of ways that 

different observers chalked the same locations. This work has nonetheless succeeded in 

discovering previously unknown rock markings which I believe will be accepted by the 

archaeological community as legitimate. Markings revealed here in the colorizations of 

CHOH-26 eluded our notice during fieldwork, when I accompanied several experienced 

archaeologists on a trip to observe the rock. This serves as a testament to the difficulty 

archaeologists face in seeing and recognizing rock markings in real field conditions, as 

well as the value of analyzing three-dimensional scans in the lab as a method of field 

verification and to inform future survey. 

With the growing availability of scanning equipment and the improving accuracy 

of consumer-grade hardware, such as LiDAR capabilities on some mobile phones, large-

area scans of suspected petroglyph sites followed by lab analysis may serve as a 

preliminary to more intensive, focused fieldwork. In this way the procedures I have 

outlined may provide a solution to the problem of targeting specific areas for attention. 

These same methods have potential application in other arenas such as historical 

archaeology, where they may prove useful in making legible eroded gravestones, 

tablets, and so forth. Perhaps most importantly, these procedures will hopefully prove 

useful to the archaeological community not only for baseline documentation and 

interpretation, but also in preserving these sites for descendant communities and 
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dispelling the pseudohistories that would deprive these communities of their cultural 

patrimonies. 

Though all too often overlooked when academics focus on empirical 

methodologies, the ethical implications for this work should not be ignored either. 

Petroglyph sites are meaningful to people in the present. This fact gives this research 

the power to be impactful, yet it also raises the stakes and risks doing real harm when 

culturally insensitive missteps occur. Robinson et al. (2021:419) have wisely called for 

“partnerships rather than appropriations” when engaging with rock-borne imagery. 

Collins, Doering, and Gonzalez (2019) offer a more exhaustive discussion of the ethical 

quandaries and potential pitfalls of this area of research. They note the balancing act 

placing open science (and concomitantly open access) at one end and the significant 

potential for misuse of information on the other. What begins with good intentions may 

result in “disreputable use of information, promoting looting, inappropriate replication of 

objects, or usage of site data for gaming or other online content” (2019:1). What is 

appropriate to replicate and publish may not be as clear as some would assume. For 

example, Indigenous ontologies do not necessarily subscribe to a stark boundary 

between the animate and inanimate, and many communities have expressed the belief 

that rock markings are living manifestations of ancestors. This suggests that discussions 

regarding the 3D scanning of rock-borne imagery should be closely intertwined with 

ethical debates about 3D modelling human remains (Spake, Nicholas, and Cardoso 

2020). Collins, Doering and Gonzalez suggest that clear authorized use and limitation 

statements can help prevent damaging mistakes. They also suggest projects for 

beneficially partnering with communities, including digital repatriation or “capacity 

building and sharing with recognized and consenting tribal entities” (24). Any such 

project should include a discussion of data sovereignty, which is an issue ultimately 

central to any question of repatriation. 
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In addition to the disreputable use of information, we must also beware the use of 

disreputable information. There are empirical concerns as well as ethical ones in the 

overlap of this research with freely or publicly available data. Compared to traditional 

archaeological materials, provenience is just as important yet not generally equally 

emphasized when handling digital data. It is taken perhaps for granted that the 

information is valid. Yet, we may over time even see the dawn of fraudulent and 

manipulated 3D models offered as ‘raw data’ by pseudoscientists and pranksters. More 

innocent but equally hazardous to research are unknown errors underlying data 

generated in good faith. Basic peer review becomes impossible without knowing the 

exact methods applied by the originators of the information, increasing the likelihood that 

mistakes will go unrecognized. This problem can be exacerbated by the democratization 

of technologies enabling advanced recording techniques, seen in the growing availability 

of devices with ‘plug-and-play,’ out-of-the-box functionality requiring minimal skill or 

specialized knowledge from the end user. The automation of critical processes ensures 

these tools generally work as intended even though their inner workings may remain 

opaque to their operators, often giving the mistaken impression that devices are 'user-

proof.’ At the same time, rejection of all but professionally recorded scans would forsake 

a resource petroglyph scholarship desperately relies upon: the many enthusiastic 

volunteers whose efforts aid professional archaeologists. I do not presume to have 

answers to these vexations, but I maintain that they are too important to the future of this 

field to leave unsaid. 

As I have thoroughly discussed in a previous chapter, this work builds upon and 

owes a great debt to previous research, especially the contributions of DeGayner, 

Rodriguez, and Moss, and Horn, Pitman, and Potter. At the same time, it carries this 

research into new territory by satisfying the practical needs of petroglyph scholarship 

which I have previously enumerated. In addition to the invention of a functional 
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methodology for petroglyph colorization, the lessons garnered by this work lead me to 

formulate a list of recommendations for archaeologists engaged in similar projects. 

Some of these recommendations pertain to the creation of data since the possibilities for 

colorization are fundamentally constrained by the characteristics of the recording. I 

recommend that a known scale of measurement be included in 3D scans, out of the way 

of the surface being recorded, in addition to clearly communicating details like the unit of 

measurement used by the file. This vastly simplifies the work of determining real-world 

surface area and calculating point density. I also recommend that sites be recorded at a 

minimum of 45,000 p/m2 in order to ensure the usefulness of the scan for colorization 

and simply for archaeological documentation. While not necessary for the colorization 

techniques developed in this study, capturing imagery for use as a texture to the scan 

can also prove invaluable both for discerning natural features in the rock and for 

detecting imagery made through color contrast. I lastly recommend that the processes I 

have developed be integrated into workflows for handling 3D petroglyph data and for 

surveying spaces suspected of containing petroglyphs. Detecting unknown rock 

markings and even relocating known sites are among the most challenging tasks facing 

archaeologists. This can present a significant problem to cultural resource managers 

who have a duty to identify, monitor, and protect rock marking sites on the lands they 

steward. Implementation of these methods can help to alleviate this problem. 

While I believe the presented techniques offer a viable route to visualizing 

markings in many different contexts and circumstances, further research would benefit 

this project greatly. Refining guidance on point cloud density seems a logical next step 

for the immediate future. The 45,000 p/m2 baseline developed here may not be ideal in 

all cases. It is possible that different point densities are more conducive to creating 

visual contrast given certain petroglyph characteristics or geological conditions. As just 

one example, a site with very large, sprawling, shallow petroglyphs could perhaps be 
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visualized better by some adjusted formula. Despite the success of the methods outlined 

here, I also suggest that future research should continue to explore other strategies for 

achieving colorizations and compare them to my own. Many novel approaches remain to 

be thoroughly tested. There are a few potentially promising techniques which I toyed 

with but excluded from this report, like exaggerating point clouds via transformation to an 

axis, akin to vertical exaggeration applied to a topographic map. The use of TPI and how 

it compares to – or may enhance – the work in this study is also deserving of thorough 

interrogation. The implications of these methods for other archaeological scholarship 

also deserve attention in the future. While these techniques should work well with any 

kind of embossing or marking, their limitations outside of a petroglyphic context are 

untested. I suspect that they may work well on eroded gravestones, faint decoration or 

surface treatment of potsherds, and so forth. I would lastly recommend that further 

research should use stakeholder-approved datasets only for developing methodology, so 

that we do not perpetuate the presentation of open data without contextual 

understanding. We should also meaningfully collaborate from the planning stage with 

any potentially affected parties. 

Rock marking research is finally receiving its limelight in American archaeology, 

and with good reason. It is not only poised to redefine our understandings of ancient 

societies, but also to reconnect descendant communities with ancestral places and 

testify to the continuities and temporal depth of Native occupation. Those who describe 

rock markings as windows to the past are perhaps a little optimistic; if they are windows, 

they are decidedly opaque. The meanings of petroglyphs and pictographs are rarely so 

legible as we would like, and things needing redress in our interpretations of rock-borne 

imagery can and will fill volumes. First, however, it would be nice if we could all agree as 

to what we are looking at. It is my hope that this study will help contribute to that mission 

and perhaps even inspire further research. Indebted as this work is to the researchers 
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before me, it seems appropriate to end with a call to action in their own words – words 

which still ring true nearly nine decades later: 

“Owing largely to methodological difficulties in the study of petroglyphs, 
archeologists have unduly neglected them….but when competent archeologists 
can be enticed to set aside their spades long enough to ponder petroglyphs, we 
may expect a much better understanding of this interesting subject.” (Steward 
1937:406) 
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APPENDIX A: GLOSSARY OF TERMS AND ACRONYMS 
 
Acronyms 

 
Glossary of Terms 

Note: Many of the following terms are used in literature and common vernacular 
with a wide variety of meanings and spellings. Throughout this work, however, 
they are applied in strict accordance with the denotations enumerated here. 

 
Anthropomorph: Imagery representing or based upon the human form. This is 
generally used to refer to depictions of a whole body rather than more specific 
anthropomorphic imagery, such as depictions of the human hand. This term may be 
used to describe human-like representations of mythical figures and does not 
necessarily denote interpretation of a human being. 

Cupule: A circular, cup-like depression ground into the surface of a stone. 

Distance computation: A calculation of Euclidean distance between all of the points on 
two clouds or meshes. This computation is conducted as a single operation using a tool 
within the CloudCompare software. It outputs a scalar field attached to one of the input 
clouds. The scalar field contains the computed distance values and manifests them by 
color. 

Downsampling: Subsampling the data in a point cloud or mesh for the purpose of 
reconstructing it at a lower resolution (i.e., with the loss of some fine detail). 

Frottage: Image transfer of texture achieved by rubbing a marking material (e.g., 
graphite) against paper which is pressed to the surface being recorded. This is also 
referred to as ‘rubbing.’ Frottage is a longstanding technique for recording rock markings 
and has been applied to recording other cultural resources, such as gravestones. 

CHOH  Chesapeake & Ohio Canal National Historical Park 

GWMP  George Washington Memorial Parkway 

NRHP  National Register of Historic Places 

NPS  National Park Service 

LiDAR Light Detection and Ranging 

GIS Geographic Information System 

DEM Digital Elevation Model 

TLS Terrestrial Laser Scanning 

TPI Topographic Position Index 

MMS Mobile Mapping System 



114 

Light Detection and Ranging (LiDAR): A remote sensing method which uses light for 
electronic distance measurement. Though technically covering any use of light for this 
purpose, the term is most commonly applied to the use of near infrared lasers in a 
pulsed Time-of-Flight system. LiDAR can generate dense, highly accurate point clouds 
and is found in aerial applications, terrestrial laser scanners, and portable handheld 
devices. 

Master Cloud: The original, unmanipulated point cloud generated by scanning a real-
world object and which forms the basis for the colorization process. The Master Cloud 
may nonetheless be preprocessed through the removal of recording errors, like plants 
and debris included in the scan. 

Mesh: An entity which uses conjoined polygons to represent the 3D surface of an object. 
A mesh is a polygonal representation of a point cloud, which forms the vertices of the 
mesh. The meshes used in this work are constructed from triangles, but other polygon 
models also exist. 

Mobile Mapping System (MMS): A portable, handheld system for capturing spatial 
environments. Mobile Mapping Systems may use laser line, photogrammetry, structured 
light, LiDAR, or other manners of data collection. 

Motif: A singular design or marking, typically one discernible by a pattern of repeated 
use.  

Petroglyph: Imagery made in rock by carving (such as by pecking, etching, and 
incising) or abrading (such as by scratching or grinding). While in some instances 
petroglyphs are formed by simply removing the darker surface layer of the rock to reveal 
a contrasting color beneath, in other cases images are made visible primarily by the 
depth of their relief. Petroglyphs are thus distinguished from other types of rock markings 
by the removal of material to make an image. 

Pictograph: Imagery made on a rock or rock-like surface by the addition of a foreign 
material such as paint or charcoal. 

Photogrammetry: Photogrammetry takes many forms, having been applied for many 
different purposes. In this work, I refer to the triangulation-based system of three-
dimensional data capture involving Structure-from-Motion and Multi-View Stereo for the 
purpose of image-based modelling. In simplest terms, a series of images of an object 
taken at different angles are input into specialized software. This software extracts key 
parameters of the capture device like position and focal length, and with this information 
uses trigonometry to calculate distances. The software then automatically generates a 
point cloud (and sometimes mesh) of the object from this information. 

Point cloud: A collection of points precisely defined in space according to a coordinate 
system. In this work, point clouds encompass the three-dimensional data about the 
surface of real-world objects. 

Rock markings: Also called “images on stone,” this is a collective term referring to 
several types of human expression through the medium of stone. I apply the phrase 
‘images on stone/rock’ or ‘rock markings’ to refer generally to petroglyphs and 
pictographs, as well as ‘mudglyphs’ despite the technically different medium of the latter. 
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Whereas other authors frequently refer to ‘rock art’ with the same meaning, I eschew the 
inaccurate and reductive characterization of rock markings as ‘art.’ This is a term borne 
of Western traditions and incompatible with the worldviews of the markings’ Indigenous 
creators. Moreover, it has been firmly rejected by many descendant communities for its 
trivial treatment of significant cultural sites. Unless specifically qualified (e.g., 
“portable/mobiliary images on stone”), this phrase is used to refer to nonportable site 
types.  

Rock varnish: A thin surface coating that develops on rockfaces through the adhesion 
and conglomeration of miniscule particles deposited by wind, water, and erosion of the 
stone itself. Rock varnishes are variously composed; their particulates often include 
silicates and iron oxides, and they may capture organic materials. 

Rock-borne imagery: An umbrella term under which all forms of rock marking and 
stone configuration are subsumed. 

Scalar field: “A function of spatial coordinates giving a single, scalar value at every 
point,” (Attenborough 2003:456). The gradients in magnitude across a scalar field are 
visually manifested by a color ramp. In this work, the scalar fields generated represent 
distance values between an original point cloud and a simulacrum. 

Simulacrum: A 3D model which is measured against the Master Cloud in the 
colorization process. This model essentially simulates the unaltered surface of a stone 
by removing fine detail. 

Structured-light scanning: A triangulation-based system of three-dimensional data 
capture wherein linear light patterns are projected onto a surface, captured with a 
camera or other recording device, and analyzed with specialized software to calculate 
distances between the surface and the scanner. The interaction of the known light 
patterns with the surface topography of the object makes these calculations possible. 

Style: A specific or specialized way of making imagery that may correspond to specific 
cultural, spatial, and temporal settings. In other words, this is essentially a consistent 
grammar of visual expression within a community of practice which some archaeologists 
argue has diagnostic and chronological value. 

Superposition: The relative positioning of rock markings that occupy the same space. 
As in the law of superposition, the placement of markings over each other can 
hypothetically allow relative dating. This is somewhat of a misnomer, however, as the 
creation of petroglyphs does not necessarily create a clear depositional sequence. In 
other literature, this is more appropriately called superimposition (i.e., one carving is 
superimposed over another). 

Terrestrial Laser Scanning (TLS): A method of scanning in which a stationary, 
grounded device uses laser light to capture three-dimensional data about an object. 
Terrestrial laser scanners generally operate on the Time-of-Flight principle, though some 
Phase-Shift and laser triangulation systems are used. This method of scanning produces 
a point cloud and may include photorealistic image capture and/or georeferencing 
depending on the model of scanner used. 
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Time-of-Flight (ToF): A system of measurement in which the time taken to reach an 
object is used to determine distance. LiDAR systems commonly employ a ToF principle, 
measuring the time for laser light to be reflected off a surface and using the known 
speed of light to then calculate distance. 

Triangle: A polygon consisting of three line segments connecting three vertices which is 
used in reconstructing the surface of a point cloud. A triangle is a type of polygonal facet 
or ‘face,’ which is the basic building block of a mesh. 

Vertex/Vertices: The points at which the edges of a polygonal facet meet on a 3D 
model. The vertices of a mesh are the same as its point cloud; the term vertex simply 
indicates that a point is functioning as part of a relationship between two or more lines. 

Weathering rind: The exterior surface of a rockface which has been directly exposed 
and subjected to geophysical processes that mechanically and chemically alter the 
stone. For example, the preferential leaching and dissolution of minerals can contribute 
to changes in the rock. These processes create a distinguishable ‘rind’ which is 
perceptibly different from the fresh stone beneath it. As weathering rinds are primarily 
created by erosional rather than depositional forces, they cannot be considered coatings 
like rock varnishes. A weathering rind may be covered by rock varnish. 

Zoomorph: Imagery apparently representing or based upon an animal. This includes 
representations of insects, birds, and quadrupeds. While ‘anthropomorph’ is preferred for 
representations unequivocally derived from the human form, ‘zoomorph’ may be used to 
describe more ambiguous or abstract representations.
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APPENDIX B: INSTRUCTIONS FOR THE APPLICATION OF A 
NOVEL METHODOLOGY 

 
B1. Methods of Colorization 
Method 1. Distance to a flat plane with Gaussian blurring and scalar field 
arithmetic: 

5) Fit a plane to the mesh or cloud. 
a. With the Master Cloud or mesh selected, Tools>Fit>Plane 

6) Compute distance between the plane and Master Cloud. 
a. With both the plane and point cloud selected, 

Tools>Distances>Cloud/Primitive Dist 
7) Apply a Gaussian filter to the created scalar field; the default sigma value 

offered by CloudCompare generally works well. 
a. With the Master Cloud or mesh selected, Edit>Scalar 

Fields>Gaussian Filter>(selected sigma value) 
8) Subtract the blurred scalar field from the original scalar field. 

a. Edit>Scalar Fields>Arithmetic>(SF1 minus SF2) 
9) Rename the resulting scalar field as desired. 

a. With the Master Cloud selected and appropriate scalar field visible, 
Edit>Scalar Fields>Rename 

 
Method 2. Distance to a subsampled and smoothed mesh: 

1) Follow the steps outlined in B2; complete Formula B. 
2) Select and random subsample the Master Cloud with the number of points to 

subsample determined by Formula B. 
• With the Master Cloud selected, Edit>Subsample>method: random, 

remaining points: (value from Formula B) 
3) Select and remesh the subsampled cloud using Delaunay 2.5D (best fitting 

plane). 
• With subsampled cloud selected, Edit>Mesh>Delaunay 2.5D (best 

fitting plane) 
4) Apply Laplacian smoothing to the subsampled mesh, 20 iterations at a 

smoothing factor of 0.2. 
• With subsampled mesh selected, Edit>Mesh>Smooth (Laplacian)>20 

iterations, 0.2 smoothing factor 
5) Compute distance between the subsampled mesh and Master Cloud. 

• With both the subsampled mesh and Master Cloud selected, 
Tools>Distances>Cloud/Mesh Dist 

6) Rename the resulting scalar field as desired. 
• With the Master Cloud selected and appropriate scalar field visible, 

Edit>Scalar Fields>Rename 
 
Method 3. Distance to a smoothed clone of the original mesh: 

7) Follow the steps outlined in B2; complete Formula A. 
8) Select and clone the original mesh. 

• With the original mesh selected, Edit>Clone 
9) Apply Laplacian smoothing to the cloned mesh with the number of smoothing 

iterations determined by Formula A. 
• With cloned mesh selected, Edit>Mesh>Smooth (Laplacian)>(input 

parameters) 
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10) Compute distance between the cloned mesh and Master Cloud. 
• With both the cloned mesh and Master Cloud selected, 

Tools>Distances>Cloud/Mesh Dist 
11) Rename the resulting scalar field as desired. 

• With the Master Cloud selected and appropriate scalar field visible, 
Edit>Scalar Fields>Rename 

 
B2. Process of Surface Area and Point Density Calculation 

1. [As needed] Clean mesh of erroneous points (e.g., leaves and branches, 
scanning errors, etc.) 

2. Calculate the scan’s surface area. 
a. Determine unit of measurement. It can be helpful to select the mesh and 

use the point picking tool to measure between two points of known real-
world distance. 

b. With mesh selected, Edit>Mesh>Measure Surface. 
c. Use the determined unit of measurement to convert the computed surface 

area (given in squared units) to square meters (𝑚𝑚2). 
3. Calculate point density. 

a. Select the point cloud and note the number of points. 
b. Divide the number of points by the surface area to arrive at points per 

square meter (𝑝𝑝 𝑚𝑚2⁄ ). 
4. Apply Formula A or Formula B in creating a visualization with a smoothed clone 

or subsampled point cloud, respectively. 
 
B3. Formulas for Use in Colorization Process 

Where 𝑝𝑝 is the number of points in the cleaned point cloud and 𝑚𝑚2 is the surface 
area of the cleaned mesh in square meters, 

Formula A: (𝑝𝑝 𝑚𝑚2⁄ ÷  45,000) × 20 = 𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠ℎ𝑖𝑖𝑖𝑖𝑖𝑖 𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 
Formula B: 45,000 × 𝑚𝑚2 = 𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝 𝑡𝑡𝑡𝑡 𝑟𝑟𝑟𝑟𝑟𝑟𝑟𝑟𝑟𝑟𝑟𝑟 𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠 

If the product of Formula B is nearly equal to or greater than the point density 
(𝑝𝑝 𝑚𝑚2⁄ ) of the scan, forego a subsampling approach and use Formula A instead. If 
Formula A returns a value below twenty, the colorization may perform poorly; smooth at 
least ten iterations regardless of value. 
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APPENDIX C: ADDITIONAL FIGURES 

Figure C1: 
CHOH-26, 
colorization 
using 
Formula A. 
Simulacrum 
smoothed 
322 
iterations at 
0.2 
smoothing 
factor. 

Figure C2: 
CHOH-26, 
colorization 
using 
Formula B. 
Simulacrum 
random 
subsampled 
160,480 
points, then 
smoothed 
20 iterations 
at 0.2 
smoothing 
factor. 
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Figure C3: CHOH-26, crevice detail. Colorization using Formula A. 

Figure C4: CHOH-26, detail view. Colorization using Formula A. 
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Figure C6: Pimmit Run Petroglyph, colorization using Formula B. Simulacrum random 
subsampled 92,899 points, then smoothed 20 iterations at 0.2 smoothing factor. 

Figure C5: Pimmit Run Petroglyph, colorization using Formula A. Simulacrum 
smoothed 309 iterations at 0.2 smoothing factor. 
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Figure C7: Octoraro Creek Petroglyphs, colorization using Formula A. Simulacrum 
smoothed 14 iterations at 0.2 smoothing factor. [Due to low point density (under 
45,000 𝑝𝑝 𝑚𝑚2⁄ ), only a colorization according to Formula A was performed.] 

Side B 

Side A 
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Figure C9: Octoraro Creek Petroglyphs, Side B. Colorization using Formula A. 

Figure C8: Octoraro Creek Petroglyphs, Side A. Colorization using Formula A. 
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Figure C10: Octoraro Creek Petroglyphs, Side A, detail view. Colorization using 
Formula A. 
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Figure C11: Judaculla Rock, colorization using Formula A. Simulacrum smoothed 20 
iterations at 0.2 smoothing factor. [Due to point density being ~45,000 𝑝𝑝 𝑚𝑚2⁄ , only a 
colorization according to Formula A was performed.] 

Side A 
Side B 
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de

 C
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Figure C12: Judaculla Rock, Side A. Colorization using Formula A. 

Figure C13: Judaculla Rock, Side B. Colorization using Formula A. 
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Figure C14: Judaculla Rock, Side C. Colorization using Formula A. 
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